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Support

Worldwide Technical Support and Product Information

ni.com

National Instruments Corporate Headquarters

11500 North Mopac Expressway Austin, Texas 78759-3504 USA Tel: 512 683 0100

Worldwide Offices

Australia 1800 300 800, Austria 43 0 662 45 79 90 0, Belgium 32 0 2 757 00 20, Brazil 55 11 3262 3599, 

Canada 800 433 3488, China 86 21 6555 7838, Czech Republic 420 224 235 774, Denmark 45 45 76 26 00, 

Finland 385 0 9 725 725 11, France 33 0 1 48 14 24 24, Germany 49 0 89 741 31 30, India 91 80 41190000, 

Israel 972 0 3 6393737, Italy 39 02 413091, Japan 81 3 5472 2970, Korea 82 02 3451 3400, 

Lebanon 961 0 1 33 28 28, Malaysia 1800 887710, Mexico 01 800 010 0793, Netherlands 31 0 348 433 466, 

New Zealand 0800 553 322, Norway 47 0 66 90 76 60, Poland 48 22 3390150, Portugal 351 210 311 210, 

Russia 7 095 783 68 51, Singapore 1800 226 5886, Slovenia 386 3 425 4200, South Africa 27 0 11 805 8197, 

Spain 34 91 640 0085, Sweden 46 0 8 587 895 00, Switzerland 41 56 200 51 51, Taiwan 886 02 2377 2222, 

Thailand 662 278 6777, United Kingdom 44 0 1635 523545

For further support information, refer to the Technical Support and Professional Services appendix. To comment 

on National Instruments documentation, refer to the National Instruments Web site at ni.com/info and enter 

the info code feedback.

© 2006 National Instruments Corporation. All rights reserved.



 Important Information

Warranty
The NI 8351 is warranted against defects in materials and workmanship for a period of one year from the date of shipment, as evidenced by 
receipts or other documentation. National Instruments will, at its option, repair or replace equipment that proves to be defective during the 
warranty period. This warranty includes parts and labor. 

The media on which you receive National Instruments software are warranted not to fail to execute programming instructions, due to defects 
in materials and workmanship, for a period of 90 days from date of shipment, as evidenced by receipts or other documentation. National 
Instruments will, at its option, repair or replace software media that do not execute programming instructions if National Instruments receives 
notice of such defects during the warranty period. National Instruments does not warrant that the operation of the software shall be 
uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside of the package before 
any equipment will be accepted for warranty work. National Instruments will pay the shipping costs of returning to the owner parts which are 
covered by warranty.

National Instruments believes that the information in this document is accurate. The document has been carefully reviewed for technical 
accuracy. In the event that technical or typographical errors exist, National Instruments reserves the right to make changes to subsequent 
editions of this document without prior notice to holders of this edition. The reader should consult National Instruments if errors are suspected. 
In no event shall National Instruments be liable for any damages arising out of or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY DISCLAIMS ANY WARRANTY OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. CUSTOMER’S RIGHT TO RECOVER DAMAGES CAUSED BY FAULT OR NEGLIGENCE ON THE PART OF 
NATIONAL INSTRUMENTS SHALL BE LIMITED TO THE AMOUNT THERETOFORE PAID BY THE CUSTOMER. NATIONAL INSTRUMENTS WILL NOT BE LIABLE FOR 
DAMAGES RESULTING FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, OR INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY 
THEREOF. This limitation of the liability of National Instruments will apply regardless of the form of action, whether in contract or tort, including 
negligence. Any action against National Instruments must be brought within one year after the cause of action accrues. National Instruments 
shall not be liable for any delay in performance due to causes beyond its reasonable control. The warranty provided herein does not cover 
damages, defects, malfunctions, or service failures caused by owner’s failure to follow the National Instruments installation, operation, or 
maintenance instructions; owner’s modification of the product; owner’s abuse, misuse, or negligent acts; and power failure or surges, fire, 
flood, accident, actions of third parties, or other events outside reasonable control.

Copyright
Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mechanical, including photocopying, 
recording, storing in an information retrieval system, or translating, in whole or in part, without the prior written consent of National 
Instruments Corporation.

National Instruments respects the intellectual property of others, and we ask our users to do the same. NI software is protected by copyright and other 
intellectual property laws. Where NI software may be used to reproduce software or other materials belonging to others, you may use NI software only 
to reproduce materials that you may reproduce in accordance with the terms of any applicable license or other legal restriction.

Trademarks
National Instruments, NI, ni.com, and LabVIEW are trademarks of National Instruments Corporation. Refer to the Terms of Use section 
on ni.com/legal for more information about National Instruments trademarks.

Other product and company names mentioned herein are trademarks or trade names of their respective companies.

Members of the National Instruments Alliance Partner Program are business entities independent from National Instruments and have no 
agency, partnership, or joint-venture relationship with National Instruments.

Patents
For patents covering National Instruments products, refer to the appropriate location: Help»Patents in your software, the patents.txt file 
on your CD, or ni.com/patents.

WARNING REGARDING USE OF NATIONAL INSTRUMENTS PRODUCTS
(1) NATIONAL INSTRUMENTS PRODUCTS ARE NOT DESIGNED WITH COMPONENTS AND TESTING FOR A LEVEL OF 
RELIABILITY SUITABLE FOR USE IN OR IN CONNECTION WITH SURGICAL IMPLANTS OR AS CRITICAL COMPONENTS IN 
ANY LIFE SUPPORT SYSTEMS WHOSE FAILURE TO PERFORM CAN REASONABLY BE EXPECTED TO CAUSE SIGNIFICANT 
INJURY TO A HUMAN.

(2) IN ANY APPLICATION, INCLUDING THE ABOVE, RELIABILITY OF OPERATION OF THE SOFTWARE PRODUCTS CAN BE 
IMPAIRED BY ADVERSE FACTORS, INCLUDING BUT NOT LIMITED TO FLUCTUATIONS IN ELECTRICAL POWER SUPPLY, 
COMPUTER HARDWARE MALFUNCTIONS, COMPUTER OPERATING SYSTEM SOFTWARE FITNESS, FITNESS OF COMPILERS 
AND DEVELOPMENT SOFTWARE USED TO DEVELOP AN APPLICATION, INSTALLATION ERRORS, SOFTWARE AND 
HARDWARE COMPATIBILITY PROBLEMS, MALFUNCTIONS OR FAILURES OF ELECTRONIC MONITORING OR CONTROL 
DEVICES, TRANSIENT FAILURES OF ELECTRONIC SYSTEMS (HARDWARE AND/OR SOFTWARE), UNANTICIPATED USES OR 
MISUSES, OR ERRORS ON THE PART OF THE USER OR APPLICATIONS DESIGNER (ADVERSE FACTORS SUCH AS THESE ARE 
HEREAFTER COLLECTIVELY TERMED “SYSTEM FAILURES”). ANY APPLICATION WHERE A SYSTEM FAILURE WOULD 
CREATE A RISK OF HARM TO PROPERTY OR PERSONS (INCLUDING THE RISK OF BODILY INJURY AND DEATH) SHOULD 
NOT BE RELIANT SOLELY UPON ONE FORM OF ELECTRONIC SYSTEM DUE TO THE RISK OF SYSTEM FAILURE. TO AVOID 
DAMAGE, INJURY, OR DEATH, THE USER OR APPLICATION DESIGNER MUST TAKE REASONABLY PRUDENT STEPS TO 
PROTECT AGAINST SYSTEM FAILURES, INCLUDING BUT NOT LIMITED TO BACK-UP OR SHUT DOWN MECHANISMS. 
BECAUSE EACH END-USER SYSTEM IS CUSTOMIZED AND DIFFERS FROM NATIONAL INSTRUMENTS' TESTING 
PLATFORMS AND BECAUSE A USER OR APPLICATION DESIGNER MAY USE NATIONAL INSTRUMENTS PRODUCTS IN 
COMBINATION WITH OTHER PRODUCTS IN A MANNER NOT EVALUATED OR CONTEMPLATED BY NATIONAL 
INSTRUMENTS, THE USER OR APPLICATION DESIGNER IS ULTIMATELY RESPONSIBLE FOR VERIFYING AND VALIDATING 



THE SUITABILITY OF NATIONAL INSTRUMENTS PRODUCTS WHENEVER NATIONAL INSTRUMENTS PRODUCTS ARE 
INCORPORATED IN A SYSTEM OR APPLICATION, INCLUDING, WITHOUT LIMITATION, THE APPROPRIATE DESIGN, 
PROCESS AND SAFETY LEVEL OF SUCH SYSTEM OR APPLICATION.



 Compliance

Compliance with FCC/Canada Radio Frequency Interference 
Regulations

Determining FCC Class
The Federal Communications Commission (FCC) has rules to protect wireless communications from interference. The FCC 
places digital electronics into two classes. These classes are known as Class A (for use in industrial-commercial locations only) 
or Class B (for use in residential or commercial locations). All National Instruments (NI) products are FCC Class A products.

Depending on where it is operated, this Class A product could be subject to restrictions in the FCC rules. (In Canada, the 
Department of Communications (DOC), of Industry Canada, regulates wireless interference in much the same way.) Digital 
electronics emit weak signals during normal operation that can affect radio, television, or other wireless products.

All Class A products display a simple warning statement of one paragraph in length regarding interference and undesired 
operation. The FCC rules have restrictions regarding the locations where FCC Class A products can be operated.

Consult the FCC Web site at www.fcc.gov for more information.

FCC/DOC Warnings
This equipment generates and uses radio frequency energy and, if not installed and used in strict accordance with the instructions 
in this manual and the CE marking Declaration of Conformity*, may cause interference to radio and television reception. 
Classification requirements are the same for the Federal Communications Commission (FCC) and the Canadian Department 
of Communications (DOC). 

Changes or modifications not expressly approved by NI could void the user’s authority to operate the equipment under the 
FCC Rules.

Class A
Federal Communications Commission
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of the FCC 
Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated 
in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and 
used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this 
equipment in a residential area is likely to cause harmful interference in which case the user is required to correct the interference 
at their own expense.

Canadian Department of Communications
This Class A digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.

Cet appareil numérique de la classe A respecte toutes les exigences du Règlement sur le matériel brouilleur du Canada.

Compliance with EU Directives
Users in the European Union (EU) should refer to the Declaration of Conformity (DoC) for information* pertaining to the 
CE marking. Refer to the Declaration of Conformity (DoC) for this product for any additional regulatory compliance 
information. To obtain the DoC for this product, visit ni.com/certification, search by model number or product line, 
and click the appropriate link in the Certification column.

* The CE marking Declaration of Conformity contains important supplementary information and instructions for the user or 
installer.
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About This Manual

The NI 8351 User Manual contains information about installing, 

configuring, using, and maintaining the NI 8351.

Conventions

The following conventions appear in this manual:

» The » symbol leads you through nested menu items and dialog box options 

to a final action. The sequence File»Page Setup»Options directs you to 

pull down the File menu, select the Page Setup item, and select Options 

from the last dialog box.

This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to 

avoid injury, data loss, or a system crash. When this symbol is marked on a 

product, refer to the Read Me First: Safety and Radio-Frequency 

Interference for information about precautions to take.

bold Bold text denotes items that you must select or click in the software, such 

as menu items and dialog box options. Bold text also denotes parameter 

names.

italic Italic text denotes variables, emphasis, a cross-reference, or an introduction 

to a key concept. Italic text also denotes text that is a placeholder for a word 

or value that you must supply.

monospace Text in this font denotes text or characters that you should enter from the 

keyboard, sections of code, programming examples, and syntax examples. 

This font is also used for the proper names of disk drives, paths, directories, 

programs, subprograms, subroutines, device names, functions, operations, 

variables, filenames, and extensions.

monospace bold Bold text in this font denotes the messages and responses that the computer 

automatically prints to the screen. This font also emphasizes lines of code 

that are different from the other examples.
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Related Documentation

The following documents contain information that you may find helpful as 

you read this manual:

• CompactPCI Specification PICMG 2.0 R 3.0

• PXI Hardware Specification, Revision 2.1

• PXI Software Specification, Revision 2.1

• ANSI/IEEE Standard 1014-1987, IEEE Standard for a Versatile 

Backplane Bus: VMEbus

• ANSI/VITA 1-1994, VME64

• NI-VISA User Manual

• NI-VISA Programmer Reference Manual

• Read Me First: Safety and Radio-Frequency Interference, National 

Instruments
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1
Getting Started

This chapter describes the key features of the NI 8351 and lists the kit 

contents and optional equipment you can order from National Instruments.

Unpacking

Carefully inspect the shipping container and the NI 8351 for damage. 

Check for visible damage to the metal work. Check to make sure all 

hardware and switches are undamaged. If damage appears to have been 

caused during shipment, file a claim with the carrier. Retain the packing 

material for possible inspection and/or reshipment.

What You Need to Get Started

The NI 8351 kit contains the following items:

❑ NI 8351 rack mount controller

❑ MXI-Express kit

❑ NI 8351 User Manual

❑ Windows recovery CD

❑ NI driver CD

❑ MXI-Express software CD

❑ Rack mount kit

❑ AC power cable (refer to Table 1-1 for a list of AC power cables)
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If you are missing any of the above items, or if you have the incorrect 

AC power cable, contact National Instruments.

Key Features

The NI 8351 combines the performance of a PC with a National 

Instruments remote controller for PXI in a rack-mountable compact 

1U form factor.

Mainboard Features

CPU

• Intel Pentium D 3.0 GHz CPU with 800 MHz FSB and 1 MB L2 cache

Chipset

• Intel E7230 chipset

• Intel ICH7R chipset

Memory

• 512 MB memory standard (2 × 256 MB ECC (32 M × 64 bit), 

unbuffered, DDR-II)

• Maximum memory supported: 8 GB 533/667 DDR-II SDRAM in 

4 DIMM sockets (240 pin)

Table 1-1.  AC Power Cables

Power Cable Reference Standards

Standard 120 V (USA) ANSI C73.11/NEMA 5-15-P/IEC83

Switzerland 220 V SEV

Australia 240 V AS C112

Universal Euro 230 V CEE (7), II, IV, VII IEC83

North America 240 V ANSI C73.20/NEMA 5-15-P/IEC83

United Kingdom 230 V BS 1363/IEC83

Japan 100 V ANSI C73.11/NEMA 5-15-P/IEC83
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Slots

• PCI Express x4 slot

Video

• ATI Radeon 7000 with 16 MB SDRAM

HDD

• 160 GB (or greater) SATA hard drive

• 3.5 in. expansion bay SATA or ATA 66/100

CD-ROM

• Slim CD-ROM drive

Onboard LAN

• Intel 82573V/L Gigabit Ethernet controller

Onboard I/O

• Floppy port

• PS/2 keyboard port

• PS/2 mouse port

• Serial port

• VGA port

• Parallel port

• Two USB 2.0 ports (rear)

• Two USB 2.0 ports (front)

• Two RJ-45 ports

Remote Controller

• MXI-Express interface



Chapter 1 Getting Started

NI 8351 User Manual 1-4 ni.com

Power Management Features

• RTC alarm and wake up

• Wake up on LAN (WOL)

• Wake up on serial ring

• Wake up on keyboard/mouse from sleep (S1)

• Wake up on USB from sleep (S1)

• Wake up on PCI

• Supports ACPI S1/S4/S5 functions

Devices

• 6 × 2 line LCD display panel

• Up, Enter, and Next buttons

Front Panel LEDs

• Power

• LAN activity

• HDD activity

System Management

• SMB (I2C)

• Temperature, voltage, and fan monitors

• Chassis intrusion



Chapter 1 Getting Started

© National Instruments Corporation 1-5 NI 8351 User Manual

NI 8351 Description

Figure 1-1 shows the key features of the NI 8351 front panel. For detailed 

information about the NI 8351 rear panel, refer to Chapter 3, I/O 

Information.

Figure 1-1.  Front View of the NI 8351

The front panel includes the following LEDs:

• Power indicator—glows when the NI 8351 is powered on.

• LAN status indicators—flash when there is activity on LAN1 or 

LAN2.

• Hard disk in use indicator—flashes when the system is accessing 

data on the hard disk.

The front panel also includes the following LCD control buttons:

• Up—Use this button to return to the previous selection.

• Enter—Use this button to execute the command.

• Next—Use this button to go to the next selection.

1 CD-ROM
2 Air Inlet
3 LCD Front Panel

4 Power Button (On/Standby)
5 USB Ports
6 LCD Control Buttons

7 Power Indicator
8 LAN Status Indicator
9 Hard Disk in Use Indicator

7

8

9

6

5

1 2 3

4



Chapter 1 Getting Started

NI 8351 User Manual 1-6 ni.com

Optional Equipment

Memory Upgrades
You can upgrade the NI 8351 memory to a maximum of 8 GB.

The NI 8351 supports dual-channel DDR-II SDRAM unbuffered memory 

in four 240-pin DIMM sockets. The NI 8351 supports ECC memory.

Note National Instruments has tested and verified that the DDR-II DIMMs we sell work 

with the NI 8351. We recommend you purchase your DDR-II DIMM modules from 

National Instruments. Other off-the-shelf DDR-II DIMM modules are not guaranteed to 

work properly.

Rack Mount Kit
A rack mount kit is included for mounting the NI 8351 chassis into a 19 in. 

instrument cabinet.

USB Floppy Disk Drive

A USB floppy drive is available from National Instruments, part number 

778492-02.

NI 8351 Overview

The NI 8351 is a 1U high rack-mountable PC with a remote controller for 

a PXI system. It is designed for PC control of a PXI test and measurement 

system using a minimum of rack space. A cable and PXI controller are 

included for connection to a PXI chassis.

The NI 8351 has an Intel Pentium D processor for high performance. This 

allows multithreaded software to better use the CPU. This often increases 

the throughput of multithreaded applications, but single-threaded 

applications may run more slowly.
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National Instruments Software

National Instruments has developed several software kits you can use with 

the NI 8351.

National Instruments hardware and software work together to help you 

make the most of your PXI Express system. The LabVIEW, Measurement 

Studio, and LabWindows™/CVI™ application development environments 

combine with leading hardware drivers such as NI-DAQmx to provide 

exceptional control of NI hardware. Instrument drivers are available at 

ni.com/idnet to simplify communication with instruments over a variety 

of buses.

LabVIEW is a powerful and easy-to-use graphical programming 

environment you can use to acquire data from thousands of different 

instruments including USB, IEEE 488.2, VXI, serial, PLCs, and plug-in 

boards. LabVIEW helps you convert acquired data into meaningful results 

using powerful data analysis routines. Add-on tools provide additional 

specialized functionality. For more information, visit ni.com/labview 

and ni.com/toolkits.

If you prefer to use Microsoft’s Visual Basic, Visual C++, and 

Visual Studio .NET for the core of your application, Measurement Studio 

adds tools for measurement and automation to each language. For more 

information, visit ni.com/mstudio.

LabWindows/CVI is an interactive ANSI C programming environment 

designed for building virtual instrument applications. LabWindows/CVI 

includes a drag-and-drop editor for building user interfaces, a complete 

ANSI C environment for building your test program logic, and a collection 

of automated code generation tools, as well as utilities for building 

automated test systems, monitoring applications, or laboratory 

experiments. For more information, visit ni.com/lwcvi.

NI-DAQmx provides an extensive library of functions you can call from 

your application development environment or interactive environment, 

such as NI Signal Express. These functions provide an intuitive API for 

National Instruments multifunction DAQ products. Features include analog 

input (A/D conversion), buffered data acquisition (high-speed A/D 

conversion), analog output (D/A conversion), waveform generation, digital 

I/O, counter/timer operations, SCXI signal conditioning, RTSI or PXI 

synchronization, self-calibration, messaging, and acquiring data to 

extended memory. For more information, visit ni.com/daq.
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National Instruments modular instruments use specialized drivers suited to 

each product’s specialization. Express VIs provide customized, interactive 

programming of instruments in a single interface, and soft front panels 

provide an interface for testing the functionality of each instrument with no 

programming required. NI switches, DMMs, high-speed DIO, high-speed 

digitizers, and sources each have customized drivers for high-end modular 

instrumentation systems. RF applications leverage two drivers, NI-RFSG 

and NI-RFSA, and dynamic signal acquisition is available through 

NI-DAQmx. For more information, visit ni.com/ 

modularinstruments.

You can expand the timing and triggering functionality of your PXI system 

with PXI timing and synchronization products. These products provide 

precision clock sources, custom routing of triggers for multichassis 

synchronization, clock sharing, and more, and are programmed with 

NI-Sync. For more information, visit ni.com/pxi.

NI-VISA is the National Instruments implementation of the VISA 

specification. VISA is a uniform API for communicating and controlling 

USB, Serial, GPIB, PXI, VXI, and various other types of instruments. This 

API aids in the creation of portable applications and instrument drivers. For 

information about writing your own PXI instrument driver with NI-VISA, 

refer to the NI-VISA Help and the readme.txt file in the NI-VISA 

directory. For more information, visit ni.com/visa.

With LabVIEW for Linux and support for more than 200 devices on Linux 

with the NI-DAQmx driver, you can now create virtual instruments based 

on the Linux OS. The NI-VISA driver for Linux has improved instrument 

control in Linux, and NI modular instruments are partially supported. For 

more information, visit ni.com/linux. 
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2
Installation and BIOS Setup

This chapter describes how to install, configure, and use the NI 8351.

Before connecting the NI 8351 to a power source, read this chapter and the 

Read Me First: Safety and Radio-Frequency Interference document 

included with your NI 8351.

Safety Information

Caution Before undertaking any troubleshooting, maintenance, or exploratory procedure, 

carefully read the following caution notices.

This equipment contains voltage hazardous to human life and safety, and is 

capable of inflicting personal injury.

• Chassis Grounding—The NI 8351 requires a connection from the 

premise wire safety ground to the NI 8351 chassis ground. The earth 

safety ground must be connected during use of this equipment to 

minimize shock hazards. Refer to the Connecting Safety Ground 

section for instructions on connecting safety ground.

• Live Circuits—Operating personnel and service personnel must not 

remove protective covers when operating or servicing the NI 8351. 

Adjustments and service to internal components must be undertaken 

by qualified service technicians. During service of this product, the 

mains connector to the premise wiring must be disconnected. 

Dangerous voltages may be present under certain conditions; use 

extreme caution.

• Explosive Atmosphere—Do not operate the chassis in conditions 

where flammable gases are present. Under such conditions this 

equipment is unsafe and may ignite the gases or gas fumes.

• Parts Replacement—Only service this equipment with parts that are 

exact replacements, both electrically and mechanically. Contact 

National Instruments for replacement part information. Installation of 

parts with those that are not direct replacements may cause harm to 

personnel operating the chassis. Furthermore, damage or fire may 

occur if replacement parts are unsuitable.
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• Modification—Do not modify any part of the NI 8351 from its 

original condition. Unsuitable modifications may result in safety 

hazards.

Chassis Cooling Considerations

The NI 8351 is designed to operate on a bench or in an instrument rack. 

Determine how you want to use the NI 8351 and follow the appropriate 

installation instructions.

Providing Adequate Clearance
Apertures in the front, rear, and along both sides of the chassis facilitate 

power supply and motherboard cooling. Air enters through the front and 

side inlets of the chassis and exits through the fans on the rear of the 

chassis. Place the NI 8351 on a bench top or in an instrument rack so that 

the fans (air outlets) and the air inlet apertures along both sides and the front 

of the chassis have adequate ventilation. Keep other equipment a minimum 

of 76.2 mm (3 in.) away from the air outlets on the rear of the chassis.

Installation

Follow these steps to connect devices to the NI 8351:

1. Connect a keyboard and mouse to the appropriate connectors on the 

NI 8351 rear panel.

2. Connect the VGA monitor video cable to the VGA connector on the 

rear panel.

3. Connect the network cable to LAN jack 1 on the rear panel.

4. Connect the USB, serial, and parallel devices as necessary to the 

NI 8351 front and rear panel ports.

Caution To minimize shock hazard, make sure the electrical power outlet you use to power 

the NI 8351 has an appropriate earth safety ground. Refer to the Connecting Safety Ground 

section for more information.

5. Connect the AC power cable to the AC inlet on the rear panel and to an 

AC power outlet. For more information, refer to Connecting to Power 

Source section.

6. Connect the MXI-Express port on the rear of the NI 8351 to the PXI 

chassis and power on the chassis.
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7. Power on the NI 8351.

8. Verify that the NI 8351 boots. If it does not boot, refer to the What if 

the NI 8351 does not boot? section of Chapter 5, Troubleshooting.

Connecting Safety Ground

The NI 8351 is designed with a three-position NEMA 5-15 style plug for 

the U.S. that connects the ground line to the chassis ground. To minimize 

shock hazard, make sure the electrical power outlet you use to power the 

chassis has an appropriate earth safety ground.

Connecting to Power Source

Attach input power through the rear AC inlet using the appropriate 

AC power cable supplied.

Caution To completely remove power, you must disconnect the AC power cable.

The power switch allows you to power on the chassis or place it in standby 

mode. Push the power switch to the On position (if not already on). Observe 

that all fans become operational and the power indicator is lit. 

BIOS Setup

This section includes information about the BIOS setup program for 

configuring the system for optimum use. You may need to run the setup 

program when:

• During the system boot, an error message requests you to run setup.

• You want to change the default settings for customized features.

Entering Setup
Power on the computer, and the system starts the POST (Power On Self 

Test) process. When the following message appears, press <F2> to enter 

setup.

Press F2 to enter SETUP

If the message disappears before you respond, and you still want to enter 

setup, restart the system by turning it off and on. You may also restart the 

system by pressing <Ctrl-Alt-Delete>.
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Getting Help
After entering the setup menu, the first menu you see is the Main menu.

Main Menu

The Main menu lists the setup functions you can change. Use the arrow 

keys (↑↓) to select an option. The highlighted setup function online 

description appears at the bottom of the screen.

Submenu

If a triangle appears to the left of an option, you can launch a submenu from 

this option. A submenu contains additional options for an option parameter. 

Use the arrow keys (↑↓) to highlight the option and press <Enter> to access 

the submenu. Then use the control keys to enter values and move from 

option to option within a submenu. To return to the main menu, press 

<Esc>.

General Help <F1>

The BIOS setup program includes a general help screen. To access this 

screen from any menu, press <F1>. The help screen lists the appropriate 

keys to use and the possible selections for the highlighted option. Press 

<Esc> to exit the help screen.

Menu Bar

When you enter the PhoenixBIOS setup utility, the Main menu appears. 

On the Main menu screen are basic BIOS settings, including system 

time and date and the setup categories the BIOS supplies. Use the arrow 

keys (↑↓) to move among the items and menus and change the settings.

Main
Use this menu for basic system configuration, such as time, date, etc.

Advanced
Use this menu to set up special enhanced features on your system chipset.

Security
Use this menu to set supervisor and user passwords.



Chapter 2 Installation and BIOS Setup

© National Instruments Corporation 2-5 NI 8351 User Manual

Power
Use this menu to specify power management settings.

Boot
Use this menu to specify the boot device priority.

Exit
Use this menu to load the BIOS default values or factory default settings 

into the BIOS and exit the BIOS setup utility with or without changes.

Main
The items in the Main menu are for basic system information and 

configuration.

Use the arrow keys (↑↓) or <Tab> to highlight the desired item or field. 

Use <+> or <–> to switch to the preferred value.

System Time
The time format is <HH> <MM> <SS>.

System Date
The date format is <YYYY> <MM> <DD>.

IDE Primary Master/Slave, SATA Port 1/2/3/4
Press <Page Up>/<+> or <Page Down>/<–> to select [Manual], [None], 

or [Auto] type. Your drive specifications must match the drive table. The 

hard disk will not work properly if you enter improper information for this 

category. If your hard disk drive type is not matched or listed, use 

[Manual] to define your own drive type manually.

If you select [Manual], you must enter information in the following items. 

Enter the information directly from the keyboard. This information should 

be in the hard disk or system documentation.

[Type] Select how to define the HDD 

parameters.
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[Multisector Transfers] Any selection except Disabled 

determines the number of sectors 

transferred per block.

[LBA Mode Control] Enabling LBA causes Logical Block 

Addressing to be used in place of 

cylinders, heads, and sectors.

[32-Bit I/O] Enables 32-bit communication between 

the CPU and IDE card.

[Transfer Mode] Selects the method for transferring the 

data between the hard disk and system 

memory.

[Ultra DMA Mode] Indicates the type of Ultra DMA.

Boot Features
Use this submenu to configure system boot features.

Floppy Check

Use this setting to cause the BIOS to search for floppy disk drives at boot 

time. When enabled, the BIOS activates the floppy disk drives during the 

boot process. The drive activity light turns on, and the head moves back and 

forth once. Options: [Disabled], [Enabled].

Summary Screen

Select [Enabled] to display the system summary screen during boot. 

Options: [Enabled], [Disabled].

Boot-Time Diagnostic Screen

Select [Enabled] to view the system diagnostic screen during boot. 

Options: [Enabled], [Disabled].

QuickBoot Mode

Set this item to [Enabled] to allow the system to boot within 5 seconds by 

skipping some check items. Options: [Enabled], [Disabled].

Installed Memory/Available to OS/Used by Devices
These read-only items show the system memory status.
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Advanced
The Advanced menu includes several submenus with more settings. To 

enter a submenu, highlight it and press <Enter>.

Advanced Chipset Control
Use this submenu to configure chipset features for optimal system 

performance.

ECC Condition

Use this setting to specify whether ECC Error Condition is detected.

ECC Error Handler

When an ECC error occurs, an interrupt is generated. Use this setting to 

select the type of interrupt to report:

[NMI] Nonmaskable Interrupt

[SMI] System Management Interrupt

[SCI] System Control Interrupt

Interleave Mode

Use this setting to determine whether the BIOS autodetects or disables the 

interleave mode.

Parallel ATA

Use this setting to enable/disable the onboard PATA controller.

Serial ATA

Use this setting to enable or disable the onchip Serial-ATA controller.

SATA Controller Mode Option

Use this setting to specify the SATA controller mode. (Pre-Win2K 

operating systems do not work in Enhanced mode.)

[Compatible] SATA and PATA drives are autodetected 

and placed in Legacy mode.

[Enhanced] (non-AHCI) SATA and PATA drives are autodetected 

and placed in Native IDE mode.
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SATA RAID Enable

Use this setting to enable or disable the RAID function for each SATA hard 

disk drive. Options: [Enabled], [Disabled].

SATA AHCI Enable

Use this setting to disable/enable Enhanced AHCI mode. The 

WinXP-SP1+IAA driver supports AHCI mode.

Advanced Processor Options
Press <Enter> to view the onboard CPU settings.

Hyperthreading

The processor uses hyperthreading technology to increase transaction rates 

and reduce end-user response times. The technology treats the two cores 

inside the processor as two logical processors that can execute instructions 

simultaneously. Therefore, system performance is highly improved. If you 

disable the function, the processor uses only one core to execute the 

instructions. Options: [Enabled], [Disabled].

Note Disable this item if your operating system does not support hyperthreading, or 

unreliability and instability may occur.

Single Logical Proc. Mode

Use this setting to control the CPU core. When set to [Disabled], the CPU 

works as multicore processor. When set to [Enabled], only a single thread 

and core are enabled.

Set Max Ext CPUID = 3

Use this setting to set the Max CPUID extended function value to 3.

Processor Power Management

Use this setting to set power management options for the processor.

[Disabled] C States and GV1/GV3 are disabled.

[GV1/GV3 Only] C States are disabled.

[C States Only] GV1/GV3 are disabled.

[Enabled] C States and GV1/GV3 are enabled.
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Hardware Monitor
Press <Enter> to enter this submenu.

Auto Fan Speed Control

Use this setting to enable/disable the Smart Fan feature. Smart Fan adjusts 

the CPU fan speed automatically depending on the CPU current 

temperature, avoiding system damage caused by overheating.

V(VCC5), V(Vcore), V(VCC3), V(V_1P5), V(12V), V(3Vsb), 
CPU/SYS Temperature, SYS Fan1/SYS Fan2 Speed

These items display the current status of all of monitored hardware 

devices/components, such as CPU voltage, temperature, and fan speed.

ASF Configuration
Use this submenu to specify the ASF configuration.

Minimum WatchDog Timeout

Use this setting to specify the minimum time period for the BIOS to stop 

the Watchdog Timer after a reset has occurred.

BIOS Boot Timeout

Use this setting to specify the time period for the BIOS to boot before the 

system is reset.

OS Boot Timeout

Use this setting to specify the time period for the OS to boot before the 

system is reset.

Power-On Wait Time

Use this setting to specify the maximum amount of time for the Alert 

Sending Device (ASD) to establish connection with its transport media.

Console Redirection
Press <Page Up>/<+> or <Page Down>/<–> to configure Console 

Redirection. The following submenus appear.
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Com Port Address

Use this setting to enable/disable the motherboard com port. Options: 

[Disabled], [Onboard COM A], [Onboard COM B].

Baud Rate

Use this setting to select the delay before key repeat. Options: [300], 

[1200], [2400], [9600], [19.2K], [38.4K], [57.6K], [115.2K].

Console Type

Use this setting to enable a specified console type. Options: [VT100], 

[VT100, 8bit], [PC-ANSI, 7bit], [PC ANSI], [VT100+], [VT-UTF8].

Flow Control

Use this setting to enable flow control. Options: [None], [XON/XOFF], 

[CTS/RTS].

Console Connection

Use this setting to indicate whether the console is connected directly to the 

system or connected via a modem. Options: [Direct], [Via modem].

Continue C. R. after POST

Select [On] to enable Console Redirection after the OS loads. Options: 

[On], [Off].

I/O Device Configuration
Use this submenu to configure I/O Devices for optimal system 

performance.

Integrated Device Control

Use this submenu to configure a specified integrated device.

Legacy USB Support

If your operating system does not support USB 1.1/2.0 or have a 

USB 1.1/2.0 driver installed (for example, DOS and SCO Unix), set this 

item to [Enabled] to use any USB 1.1/2.0 device. Options: [Disabled], 

[Enabled].
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Serial Port A/B

Use these settings to specify the onboard Serial Port A/B base I/O port 

addresses. Select [Auto] to allow the BIOS to determine the correct base 

I/O port address automatically. Options: [3F8/IRQ4], [2F8/IRQ3], 

[3E8/IRQ4], [2E8/IRQ3], and [Disabled].

Parallel Port

Set this item to [Enabled] to configure the parallel port base I/O address 

and IRQ manually. Options: [Enabled], [Disabled].

Mode

Select an operating mode for the onboard parallel (printer) port.

[Output Only] Standard parallel port

[EPP] Enhanced parallel port

[ECP] Extended capability port

[Bidirectional] SPP duplex mode

To operate the onboard parallel port as Standard parallel port only, select 

[Output Only]. To operate the onboard parallel port in the EPP mode 

simultaneously, select [EPP]. By selecting [ECP], the onboard parallel 

port operates in ECP mode only. Selecting [Bidirectional] allows the 

onboard parallel port to support SPP duplex mode.

Base I/O Address

Use this setting to specify the base I/O port addresses of the onboard 

parallel port. Options: [378], [278], [3BC]. (This setting is not available 

when the parallel port is set to [EPP] mode.)

Interrupt

Use this setting to specify the parallel port interrupt. Options: [IRQ 5], 

[IRQ 7].

Floppy Disk Controller

Use this setting to enable or disable the onboard floppy controller. Select 

[Enabled] when you have installed a floppy disk drive. Options: 

[Enabled], [Disabled].
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Base I/O Address

Use this setting to specify the onboard floppy base I/O port address.

DMI Event Logging
Press <Page Up>/<+> or <Page Down>/<–> to view DMI event logging.

View DMI Event Log

Press <Enter> to view the DMI event log contents.

Event Logging

Use this setting to disable/enable the BIOS to log Desktop Management 

Interface (DMI) events. Options: [Disabled], [Enabled].

ECC Event Logging

Use this setting to disable/enable the BIOS to log Error Checking and 

Correcting (ECC) events. Options: [Disabled], [Enabled].

Mark DMI Events as Read

Press <Enter> and a screen appears, asking you to confirm whether to clear 

all DMI event logs immediately. Press <Y> and <Enter>, and the BIOS 

clears all DMI event logs right away.

Clear All DMI Event Logs

When you set this setting to [Yes], the DMI event log is cleared at the next 

POST stage. Then, the BIOS automatically sets this option to [No]. 

Options: [Yes], [No].

Security
Use this menu to set security passwords to control system access at boot 

time and when entering the BIOS setup program.

Supervisor Password Is/User Password Is
This read-only item shows the preset supervisor/user password.

Set Supervisor Password
Use this setting to control access to the BIOS Setup utility.
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Set User Password
Use this setting to control access to the system at boot.

Virus Check Reminder/System Backup Reminder
Use this setting to display a reminder message at boot (daily, every 

Monday, or first of every month).

Password on Boot
Selecting [Enabled] requires a password on boot and prior setting of the 

supervisor password. If the supervisor password is set and this option is 

disabled, the BIOS assumes the user is booting. Options: [Enabled], 

[Disabled].

Power
Use this menu to specify your power management settings. The options 

available depend on the hardware installed in your system.

Resume on Modem Ring
Select [On] to wake up the system when an incoming call on the modem is 

detected. Options: [On], [Off].

Resume on Time
Select [On] to wake up the system at a predetermined time. Options: [On], 

[Off].

Resume Time
The time format is <HH> <MM> <SS>.

Resume Date
The date format is <MM> <DD> <YYYY>.

Resume on LAN
Select [Enabled] to wake up the system when incoming signals are 

detected on the specified LAN devices. Options: [Enabled], [Disabled].
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After Power Failure
Use this setting to specify whether your system reboots after a power 

failure or interrupt occurs. Available settings are:

[Stay Off] Returns the system to an off state.

[Power On] Returns the system to a full on state.

[Last State] Restores the system to the previous status before the 

power failure or interrupt occurred.

Boot
Use this menu to set the operating system boot device priority.

Boot Priority Order
Use this setting to set the boot priority of the specified devices. Press 

<Enter> to enter the submenu and:

• Use the arrow keys (↑↓) to select the desired device.

• Press <Page Up>/<+> or <Page Down>/<–> to move the device up or 

down in the priority list.

• Use <X> to exclude/include the device to boot.

• Use <R> or <F> to specify the USB ZIP to be the removable device 

(<R>) or hard drive (<F>).

Excluded from Boot Order
Use this setting to exclude the specified devices from the boot order list.

Exit
Use this menu to exit the BIOS setup. Note that <Esc> does not exit this 

menu. You must select an item from the menu or menu bar to exit.

Exit Saving Changes
Select this option to save the changes and quit.

Exit Discarding Changes
Select this option to abandon the changes and quit.
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Load Setup Defaults
Use this option to restore all BIOS settings to the optimal defaults. The 

setup defaults are the manufacturer default values for optimized mainboard 

performance.

Discard Changes
Use this option to restore all BIOS settings to previous values.

Save Changes
Use this option to save the changes without exiting the Setup menu.

Drivers and Software

Files and Directories Installed on Your Hard Drive
Your hard drive includes a directory called images in its root that 

contains software and soft copies of manuals for the peripherals. The 

directory structure under the images directory is logically organized into 

several levels.

In the images directory, you will find a manuals directory, 

an os directory, and directories for each computer peripheral.

The manuals directory contains quick reference guides, technical 

reference manuals, and National Instruments software manuals, all in 

Adobe Acrobat format. To access any manual, change your directory to 

c:\images\ni8351\manuals and list the contents of that directory. You 

will see several files, one corresponding to each peripheral.

The os directory contains a subdirectory corresponding to the operating 

system installed on your computer.

The rest of the directories correspond to each peripheral in your system. 

Within these directories are the peripheral drivers. These files and 

directories are copied exactly from the manufacturer distribution disks, so 

the naming conventions vary from peripheral to peripheral.
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LCD Function Menu

Three buttons control the LCD function panel:

• Up—Go to the previous selection.

• Enter—Execute the command.

• Next—Go to the next selection.

You can use the LCD front panel control buttons to access information 

under the LCD Info, H/W Monitor, and System Conf menus. The menu 

structures are shown in Figures 2-1 and 2-2.

Figure 2-1.  LCD Info and H/W Monitor Control Panel Menu Structure

LCD Info

Firmware

Mode

Build Date

Baud Rate

Character

H/W Monitor

CPU Temp

Chassis Temp

System FAN

Power FAN

V Core

5 V

Chassis Int
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Figure 2-2.  System Conf Control Panel Menu Structure

System Conf
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Time
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Hard Disk
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Restart OS

Shutdown OS

Set Date

Set Time
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Available
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Usage

Available

Size

Usage

Available

Size

Usage

Available

Size

Usage

Available

Disk C

Disk D

Disk E

Disk F

IP

Net Mask

Set IP

Set Net Mask

Yes

No

IP

Net Mask

Set IP

Set Net Mask

Yes

No
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Table 2-1 describes the debug functions that appear in the LCD before the 

NI 8351 boots to OS.

Table 2-1.  Debug Functions Before Boot to OS

Function Description

LCD Panel v1.1

Initialize OK

Show product information and version.

BIOS POST: C1

Msg: Mem Sizing

If the system has memory problems, it stops at C1.

BIOS POST: C3

Msg: BIOS chsum

If the system has BIOS problems, it stops at C3.

BIOS POST: 18

Msg: CPU Init.

If the system has CPU problems, it stops at 18.

BIOS POST: 2B

Msg: VGA Init.

If the system has VGA problems, it stops at 2B.

BIOS POST: 2D

Msg: Sign-on Msg.

Shows information about logo processor brand name.

BIOS POST: 52

Msg: Ext. Mem Test

If the system has memory problems, it stops at 52.

BIOS POST: 75

Msg: IDE Init.

If the system has IDE problems, it stops at 75.

BIOS POST: 8B

Msg: PCI ROM Init.

If the system has PCI problems, it stops at 8B.

BIOS POST: 94

Msg: disp summary

<Boot to OS> If the system is problem free, it boots to OS.
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Table 2-2 describes the LCD Info functions that appear in the LCD.

Table 2-3 describes the H/W Monitor functions that appear in the LCD.

Table 2-2.  LCD Info Functions

Function Description

Firmware 1/5

V1.1

Show LCD firmware version

Mode  2/5

Communication

Show LCD working mode

Build Date  3/5

2002/03/25

Show LCD firmware build date

Baud Rate  4/5

9600

Show LCD communication speed with COM port

For PC and LCD link

Character  5/5

16X2

Show LCD characters

Table 2-3.  H/W Monitor Functions

Function Description

CPU 1/15

42C

Show CPU temperature information

Chassis 2/15

28C

Show chassis temperature information

System FAN 3/15

0 RPM

Show system fan speed information

Power FAN 4/15

4219 RPM

Show power fan speed information

V core 6/15

1.46 V

Show V core voltage information

+5 V 9/15

5.07 V

Show +5 V voltage information

Chassis int 15/15

OFF

Show chassis intrusion detect information
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Table 2-4 describes the System Conf functions that appear in the LCD.

Table 2-4.  System Conf Functions

Function Description

Host name 1/9 Show system host name

Date 2/9

2002.8.21

Set Date 1/1 Show the date and allow to set the date

Time 3/9

13:24:50

Set Time 1.1 Show the time and allow to set the time

Memory 4/9 Size 1/3 Show memory size

511MB

Usage 2/3 Unable to show used memory size

153MB

Available 3/3 Unable to show available memory size

358MB

Hard Disk 5/9

Information

Can detect four hard disks on the system

Disk C 1/4

3698 MB

Size 1/3 Show partition size

3698 MB

Usage 2/3 Unable to show the used size

1485 MB

Available 3/3 Unable to show the available size

2213 MB

Disk D 2/4

15393 MB

Size 1/3 Show partition size 

15393 MB

Usage 2/3 Unable to show the used size

494 MB

Available 3/3 Unable to show the available size

14899 MB
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Disk E  3/4

0 MB

Size 1/3 Show partition size 

0 MB

Usage 2/3 Unable to show the used size

0 MB

Available 3/3 Unable to show the available size 

0 MB

Disk F 4/4

0 MB

Size 1/3 Show partition size 

0 MB

Usage 2/3 Unable to show the used size 

0 MB

Available 3/3 Unable to show the available size

0 MB

LAN1 6/9

100.100.100.101

IP 1/4 Show the system IP information

100.100.100.101

Netmask 2/4 Show the system Net Mask information

255.255.255.0

Set IP Allow users to set the system IP

000.000.000.000

Setmask Allow users to set the system Net Mask

000.000.000.000

LAN2 7/9

100.100.100.101

IP 1/4 Show the system IP information

100.100.100.101

Netmask 2/4 Show the system Net Mask information

255.255.255.0

Set IP Allow users to set the system IP

000.000.000.000

Setmask Allow users to set the system Net Mask

000.000.000.000

Table 2-4.  System Conf Functions (Continued)

Function Description
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Rack Mounting

Follow these steps to rack mount the NI 8351:

1. Attach the rack mount handles to the NI 8351 front panel using the 

black M4x6 screws.

Restart 8/9

Restart OS

Yes/No Restart your Windows OS

Shutdown 9/9

Shutdown OS

Yes/No Shut down your Windows OS

1 Rack Mount Handle 2 M4x6 Screws

Table 2-4.  System Conf Functions (Continued)

Function Description

1

2



Chapter 2 Installation and BIOS Setup

© National Instruments Corporation 2-23 NI 8351 User Manual

2. Attach the side rails to the sides of the NI 8351 using four M4x6 screws 

on each side.

3. Attach the mounting brackets to the rack rails using M4x6 screws and 

M4 nuts. The rear bracket position is adjustable; attach the rear bracket 

so that it aligns with the rear rail on the rack.

1 Side Rail 2 M4x6 Screws

1 Mounting Bracket
2 M4x6 Screw

3 M4 Nut
4 Rack Rail

1 2

1 12

43 3

2
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4. Attach the rack rails to the rack using the M5x8 screws and the 

two-hole rack mounting plates.

5. Align the rails on the NI 8351 with the rack rails. Slide the NI 8351 

halfway into the rack.

1 M5x8 Screw
2 Two-Hole Mounting Plate

3 Rack Rail
4 Rack

1

3 212

4
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6. Press the locking tabs on both sides of the NI 8351 and slide the 

NI 8351 fully into the rack.

Note The locking tabs lock the NI 8351 halfway into the rack, so that it cannot slide out. 

When removing the NI 8351, pull the locking tabs forward to unlock them.

7. Secure the NI 8351 to the rack with the mounting screws.

Hard Drive Recovery

The NI 8351 includes two methods of restoring the original factory 

condition of your hard drive. Hard drive-based recovery stores a factory 

backup on a separate part of your hard drive, allowing you to restore your 

controller without additional media. The NI 8351 also ships with an OS 

Recovery CD that allows you to reinstall your operating system onto your 

hard drive via an external CD-ROM. For more information about these 

tools, refer to KnowledgeBase 2ZKC02OK at ni.com/support.

Note Recovering the OS erases the contents of your hard disk. Back up any files you want 

to keep.

Installing an OS

The NI 8351 includes a preinstalled OS. In some cases, you may want to 

reinstall the OS or install a different OS from the integrated CD-ROM 

drive. To install from the CD-ROM drive, you must change the boot 

device; refer to the Boot Priority Order section for more information.

1 Locking Tab

1
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Cleaning

Caution Always disconnect the AC power cable before cleaning or servicing the chassis.

Exterior Cleaning

Cautions Avoid getting moisture inside the chassis during exterior cleaning, especially 

through the top vents.

Do not wash the front- or rear-panel connectors or switches. Cover these components while 

cleaning the chassis.

Do not use harsh chemical cleaning agents; they may damage the chassis. Avoid chemicals 

that contain benzene, toluene, xylene, acetone, or similar solvents.

Clean the exterior surfaces of the chassis with a dry lint-free cloth or a 

soft-bristle brush. Do not use abrasive compounds on any part of the 

chassis.
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3
I/O Information

Rear Panel Connectors

Table 3-1 lists various peripherals and their corresponding NI 8351 

external connectors, bus interfaces, and functions.

Table 3-1.  NI 8351 Peripherals Overview

Peripheral External Connector Description

Keyboard PS/2 (5-pin Din) PS/2-style keyboard

Mouse PS/2 (5-pin Din) PS/2-style mouse

USB USB 4-pin Series A stacked 

receptacle

USB 2.0 capable

USB USB 4-pin Series A stacked 

receptacle

USB 2.0 capable

Parallel Parallel Port (36-pin champ) IEEE 1284

Serial COM1 (9-pin DSUB) 16550 RS-232 serial port

Video VGA (15-pin DSUB) Intel Extreme Graphics controller

Ethernet LAN (RJ45) 10/100 Ethernet connection

Ethernet LAN (RJ45) 10/100 Ethernet connection
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Figure 3-1 shows the rear panel layout of the NI 8351.

Figure 3-1.  NI 8351 Rear Panel Layout

PS/2
Figure 3-2 shows the location and pinouts for the PS/2 keyboard and mouse 

connectors on the NI 8351. Table 3-2 lists and describes the PS/2 connector 

signals.

Figure 3-2.  PS/2 Connector Location and Pinout

1 PS/2 Mouse Connector
2 PS/2 Keyboard Connector

3 Serial Port
4 VGA Port

5 USB Ports
6 LAN 2

7 LAN 1
8 Parallel Port

Table 3-2.  PS/2 Connector Signals

Pin Signal Name Signal Description

1 DATA Data Keyboard

2 NC Data Mouse

3 4 5

8

1

2

7

6

PS/2

12

4 3

56
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Universal Serial Bus
Figure 3-3 shows the location and pinouts for the Universal Serial Bus 

(USB) connectors on the NI 8351. Table 3-3 lists and describes the USB 

connector signals.

AMP manufactures a USB mating connector, part number 787633.

Figure 3-3.  USB Connector Location and Pinout

3 GND Ground

4 VCC VCC

5 CLK Clock Keyboard

6 NC Clock Mouse

Table 3-3.  USB Connector Signals

Pin Signal Name Signal Description

1 VCC Cable Power (+5 V)

2 –Data USB Data–

3 +Data USB Data+

4 GND Ground

Table 3-2.  PS/2 Connector Signals (Continued)

Pin Signal Name Signal Description

USB

41
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Parallel Port
Figure 3-4 shows the location and pinouts for the IEEE 1284 (parallel) 

connector on the NI 8351. Table 3-4 lists and describes the IEEE 1284 

connector signals.

Figure 3-4.  Parallel Port Connector Location and Pinout

Table 3-4.  Parallel Port Connector Signals

Pin

Default Configuration (LPT)

Signal Name Signal Description

1 BUSY Device Busy

2 SLCT Select

3 ACK* Acknowledge

4 FAULT*(ERROR*) Fault

5 PAPEREND Paper End

6 PD0 Data Bit 0

7 PD1 Data Bit 1

8 PD 2 Data Bit 2

9 PD3 Data Bit 3

10 PD4 Data Bit 4

11 PD5 Data Bit 5

Parallel Port

113

1425
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Serial
Figure 3-5 shows the location and pinouts for the serial connector on the 

NI 8351. Table 3-5 lists and describes the serial connector signal.

AMP manufactures a serial port mating connector, part number 745491-5.

Figure 3-5.  Serial Connector Location and Pinout

12 PD6 Data Bit 6

13 PD7 Data Bit 7

14 INIT* Initialize Printer

15 STROBE* Strobe

16 SLCTIN* Select Input

17 AUTOFD* Auto Line Feed

18 +5V +5 V

19–35 GND Ground

36 NC Not Connected

Table 3-4.  Parallel Port Connector Signals (Continued)

Pin

Default Configuration (LPT)

Signal Name Signal Description

1 5

96

Serial
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VGA
Figure 3-6 shows the location and pinouts for the VGA connector on the 

NI 8351. Table 3-6 lists and describes the VGA connector signals.

AMP manufactures a mating connector with part numbers 748364-1 

(housing) and 748333-2 (pin contact).

Figure 3-6.  VGA Connector Location and Pinout

Table 3-5.  Serial Connector Signals

Pin Signal Name Signal Description

1 DCD* Data Carrier Detect

2 SIN* Receive Data

3 SOUT* Transmit Data

4 DTR* Data Terminal Ready

5 GND Ground

6 DSR* Data Set Ready

7 RTS* Ready to Send

8 CTS* Clear to Send

9 RI* Ring Indicator

VGA

15

10

5

11

6

1
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Ethernet
Figure 3-7 shows the location and pinouts for the Ethernet connectors 

on the NI 8351. Table 3-7 lists and describes the Ethernet connector 

signals.

AMP manufactures a mating connector, part number 554739-1.

Table 3-6.  VGA Connector Signals

Pin Signal Name Signal Description

1 R Red

2 G Green

3 B Blue

4 NC Not Connected

5 GND Ground

6 GND Ground

7 GND Ground

8 GND Ground

9 +5V 5 V

10 GND Ground

11 NC Not Connected

12 SD Serial Data

13 HSync Horizontal Sync

14 VSync Vertical Sync

15 SC Serial Clock
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Figure 3-7.  Ethernet Connector Location and Pinout

MXI-Express Connectors

Refer to your MXI-Express hardware user manual for connector 

information.

Table 3-7.  Ethernet Connector Signals

Pin Signal Name Signal Description

1 D0P Differential Pair 0+

2 D0N Differential Pair 0–

3 D1P Differential Pair 1+

4 D2P Differential Pair 2+

5 D2N Differential Pair 2–

6 D1N Differential Pair 1–

7 D3P Differential Pair 3+

8 D3N Differential Pair 3–

Ethernet

18
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4
Common Configuration 
Questions

This chapter answers common configuration questions you may have when 

using the NI 8351.

General Questions

What do the LEDs on the NI 8351 front panel mean?

The power indicator lights when the main power is turned on. The LAN 

status LEDs flash to when there is activity on LAN1 and LAN2. The hard 

drive LED lights when there is hard drive activity on the NI 8351. For more 

information, refer to Figure 1-1, Front View of the NI 8351.

How do I check the configuration of the memory, hard drive, 

time/date, and so on?

You can view these parameters in the BIOS setup. To enter the BIOS setup, 

reboot the NI 8351 and press <F2> during the memory tests. Refer to the 

BIOS Setup section of Chapter 2, Installation and BIOS Setup, for more 

information.

Can I use the internal SATA drive and an external hard drive at the 

same time?

Yes.

Boot Options

What devices can I boot from?

The NI 8351 can boot from the following devices:

• The internal SATA hard drive

• The internal CD-ROM drive

• A network PXE server on the same subnet
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• An external USB mass storage device such as a USB hard drive or 

CD-ROM

Note You should enable Legacy USB support to boot from USB devices. Refer to the 

BIOS Setup section of Chapter 2, Installation and BIOS Setup, for more information.

• An external USB floppy drive

Note There are some limitations when booting from a USB device. Windows XP can 

be installed from a USB CD-ROM, but earlier versions of Windows cannot. The NI 8351 

BIOS configures the USB devices so that they will work in a DOS environment.

How do I configure the controller to boot from these devices?

Press <F2>, enter the BIOS, and select Boot. You can set the boot order 

using <+> and <–>. Set the order by device type and set the order for the 

devices listed within the device type. Refer to BIOS Setup in Chapter 2, 

Installation and BIOS Setup, for more information.

Chassis Configuration

How do I set up the NI 8351 to work with my PXI chassis?

Configuration of the PXI system is handled through Measurement & 

Automation Explorer (MAX), included with the software pre-installed 

on your NI 8351. MAX creates the pxisys.ini file, which defines 

the layout and parameters of your PXI system. 

The configuration steps for single or multiple-chassis systems are the same.
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Figure 4-1.  Multichassis Configuration in MAX

Basic PXI System Configuration

1. Launch MAX.

2. In the Configuration tree, click the Devices and Interfaces branch to 

expand it.

3. If the PXI system controller has not yet been configured, it is labeled 

PXI System (Unidentified). Right-click this entry to display the 

pop-up menu, then select the appropriate controller model from the 

Identify As submenu.

4. Click the PXI System controller. The chassis (or multiple chassis in a 

multichassis configuration) is listed below it. Identify each chassis by 

right-clicking its entry, then selecting the appropriate chassis model 

through the Identify As submenu. Further expanding the PXI System 

branch shows all devices in the system that can be recognized by 

NI-VISA. When your controller and all your chassis are identified, the 

required pxisys.ini file is complete.
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The PXI specification allows many combinations of PXI chassis and 

system modules. To assist system integrators, the manufacturers of 

PXI chassis and system modules must document the capabilities of their 

products. The minimum documentation requirements are contained in 

.ini files, which consist of ASCII text. System integrators, configuration 

utilities, and device drivers can use these .ini files. 

The capability documentation for the chassis is contained in a 

chassis.ini file provided by the chassis manufacturer. The information 

in this file is combined with information about the system controller to 

create a single system initialization file called pxisys.ini (PXI System 

Initialization). The NI 8351 uses MAX to generate the pxisys.ini file 

from the chassis.ini file.

Device drivers and other utility software read the pxisys.ini file to 

obtain system information. For detailed information about initialization 

files, refer to the PXI specification at www.pxisa.org.

Upgrade Information

How do I upgrade system memory?

Refer to Upgrading Memory in Appendix B, Hardware Configuration.

How do I flash a new BIOS?

You can download the new BIOS from ftp.ni.com/support/pxi/. 

For more information, refer to KnowledgeBase 3H3COSD8 at ni.com.

Where do I get the latest software drivers?

The latest National Instruments software is available from ni.com/ 

downloads/. For peripheral drivers, refer to KnowledgeBase 3H3COSD8 

at ni.com.

My NI 8351 does not have an internal floppy drive. Is there a way to 

use an external drive?

Yes. The NI 8351 controller supports and can boot from USB floppy drives. 

A USB floppy drive will not work with Windows NT4, but will work with 

Windows 2000 or Windows XP. Refer to the Boot Options section for more 

information.

A USB floppy drive is available from National Instruments, part number 

778492-02.
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5
Troubleshooting

This chapter answers common troubleshooting questions you may have 

when using the NI 8351.

What if the NI 8351 does not boot?

Several problems can cause a controller not to boot. Here are some things 

to look for and possible solutions.

Things to Notice:

• Which LEDs come on? The power indicator LED should stay lit. The 

hard disk drive LED should blink during boot as the disk is accessed.

• What appears on the display? Does it hang at some particular point 

(BIOS, Operating System, and so on)? If nothing appears on the 

screen, try a different monitor. Does your monitor work with a 

different PC? If it hangs, note the last screen output that you saw for 

reference when consulting National Instruments technical support.

• What has changed about the system? Did you recently move the 

system? Was there electrical storm activity? Did you recently add 

a new module, memory chip, or piece of software?

Things to Try:

• Make sure the NI 8351 is plugged in to a working power source. 

• Remove any nonessential cables or devices.

• Make sure the CPU and memory modules are properly seated in their 

slots.

• Clear the CMOS. (Refer to the Clear CMOS Jumper: JBAT1 section 

of Appendix B, Hardware Configuration.)

• Recover the hard drive on the NI 8351. (Refer to the Hard Drive 

Recovery section of Chapter 2, Installation and BIOS Setup.)

My NI 8351 boots fine until I get to Windows, at which point I cannot 

read the screen. This may include garbled output, white screen, black 

screen, or an out of synch message from the monitor.

This problem usually results from having the video card output set past the 

limits of the monitor. You will need to boot Windows in Safe Mode. To do 
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this, reboot the NI 8351. As Windows begins to boot, hold down <F8>. You 

should now be able to reset the video driver to lower settings. Try setting 

the resolution to 640 × 480 and the refresh rate to 60 Hz. Once you reboot, 

you can raise these values again, using the test option in Windows. These 

settings are accessible through the Advanced tab of the Display item in the 

Control Panel. Alternately, you can try a different monitor, preferably a 

newer and larger one.

My system boots fine as long as a particular module is not in my 

chassis.

The most common cause of this is a damaged module. Try the module in a 

different chassis or with a different controller. Also, remove any external 

cables or terminal blocks connected to the system. If the module does not 

work in these cases, it is likely damaged. Contact the module manufacturer 

for further troubleshooting.

Refer to the KnowledgeBase or product manuals section at ni.com for 

more information specific to the chassis and module with which you are 

having difficulties.

How do I set Windows to prompt me before shutting down when I press 

the power button?

Select Start»Control Panel»Power Options to open the Power Options 

Properties window. Select the Advanced tab. In the Power buttons 

section, select Ask me what to do from the pull-down menu. When this is 

selected, Windows prompts you to cancel, shut down, or restart when you 

press the power button.
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A
Specifications

This appendix lists the NI 8351 electrical, mechanical, and environmental 

specifications.

Electrical

AC Input
Input voltage range................................. 100–240 VAC

Operating voltage range1........................ 90–264 VAC

Input frequency ...................................... 50/60 Hz

Operating frequency range1 ................... 47–63 Hz

Input current rating................................. 6–3 A

Power disconnect ................................... The AC power cable provides 

main power disconnect. 

Depressing the front panel power 

switch enables or inhibits the 

internal power supply.

Mainboard
Socket..................................................... LGA 775

Chipset ................................................... Intel E7230 chipset, supports 

533/800/1066 MHz FSB, 4 GB 

dual-channel DDR-II memory

Memory Slots......................................... Four 240-pin DIMM slots, 

two per channel

PCI ......................................................... One PCI Express x4 slot

1   Operating range is guaranteed by design.
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SATA......................................................Four SATA ports compliant with 

the Serial-ATA 2.0 specification. 

Maximum data rate of 300 MB/s

IDE..........................................................One primary and one secondary 

IDE connector. Ultra DMA 

66/100 support

USB ports ...............................................Four USB 2.0 ports

Keyboard ................................................PS/2 keyboard port

Mouse .....................................................PS/2 mouse port

Video ......................................................VGA port, onboard ATI 

Radeon 7000 with 16 MB 

SDRAM

Serial .......................................................One RS-232 serial port

Parallel ....................................................One parallel port

LAN ........................................................Two RJ45 LAN jacks

Onboard LAN controller ........................Intel 82573V/L Gigabit Ethernet 

controller

CPU
CPU ........................................................Intel Pentium D

Clock speed.............................................3.0 GHz

Front side bus speed ...............................800 MHz

L2 cache..................................................1 MB/core

Package ...................................................LGA 775

Hard Disk Drive
Capacity ..................................................160 GB or larger

Interface ..................................................Serial-ATA
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Memory
Standard memory ................................... 2 × 256 MB (32 M × 64 bit), 

DDR-II SDRAM, ECC 533 MHz, 

unbuffered, 240-pin DIMMs

2.5 GB memory upgrade........................ Standard memory plus 2 × 1 GB 

(128 M × 64 bit), DDR-II 

SDRAM, ECC 533 MHz, 

unbuffered, 240-pin DIMMs

4 GB memory upgrade........................... 4 × 1 GB (128 M × 64 bit), 

DDR-II SDRAM, ECC 533 MHz, 

unbuffered, 240-pin DIMMs,

Mechanical
Overall dimensions (standard chassis)

Height.............................................. 43.2 mm (1.70 in.)

Width .............................................. 435.1 mm (17.13 in.)

Depth............................................... 434.4 mm (17.10 in.)

Weight .................................................... 8.6 kg (19.0 lbs)

Environmental
Operating temperature............................ 5 to 35 °C

Storage temperature ............................... –10 to 60 °C

Relative humidity

Operating ........................................ 10 to 90% noncondensing

Nonoperational (storage) ................ 5 to 95% nonconducting

Operating location.................................. Indoor use

Altitude................................................... 2,000 m

Installation Category .............................. II

Pollution Degree .................................... 2
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Safety
This product is designed to meet the requirements of the following 

standards of safety for information technology equipment:

• IEC 60950-1, EN 60950-1

• UL 60950-1

• CAN/CSA-C22.2 No. 60950-1

Note For UL and other safety certifications, refer to the product label, or visit 

ni.com/certification, search by model number or product line, and click the 

appropriate link in the Certification column.

Electromagnetic Compatibility
Emissions................................................EN 55011 Class A at 10 m. 

FCC Part 15A above 1 GHz

Immunity ................................................EN 61326:1997 + A2:2001, 

Table 1

CE, C-Tick, and FCC Part 15 (Class A) Compliant

Note For EMC compliance, operate this device with shielded cabling.

CE Compliance
This product meets the essential requirements of applicable European 

Directives, as amended for CE Marking, as follows:

Low-Voltage Directive (safety)..............73/23/EEC

Electromagnetic Compatibility

Directive (EMC) ..................................... 89/336/EEC

Note Refer to the Declaration of Conformity (DoC) for this product for any additional 

regulatory compliance information. To obtain the DoC for this product, visit 

ni.com/certification, search by model number or product line, and click the 

appropriate link in the Certification column.
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B
Hardware Configuration

Caution Hazardous Voltage Area

No user (operator) serviceable parts are inside the NI 8351.

The hardware configuration and upgrade procedures described in this appendix must be 

performed only by a qualified service technician.

Disconnect the power cord before servicing.

Figure B-1 shows the key features of the NI 8351 mainboard.
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Figure B-1.  NI 8351 Mainboard Layout

1 CPU_FAN1
2 CPU Socket
3 Intel 7230
4 SYSFAN2/1
5 DIMM 1
6 DIMM 2
7 DIMM 3
8 DIMM 4
9 ATX1
10 COM2
11 JLCD1

12 JUSB2
13 JACT1/2
14 JFP1
15 SATA4
16 SATA3
17 IDE1
18 SYSFAN4
19 SYSFAN3
20 ATI Radeon 7000
21 SATA2
22 SATA1

23 JCI1
24 JBAT1
25 Battery
26 Intel ICH7R
27 JUSB1
28 BIOS
29 J2
30 FDD1
31 JCD1
32 JGS1
33 PCIX1

34 J8
35 RJ45 LAN Jacks
36 J5
37 JPW1
38 USB Ports
39 Top—LP1; Bottom— 

COM A, VGA Port
40 PS/2 Connectors 

(Top—Mouse;
Bottom—Keyboard)

1 2 5 7 86

10

11

12

14

15

16

17

13

31 2529 28 262730

40

35

39

32

37

4 9

18

19

21

22

23

24

20

3

38

33

34

36
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Jumper Settings

Figure B-1 shows the jumper locations on the NI 8351.

Figure B-1.  NI 8351 Jumper Locations

1 J5 2 J8 3 J2 4 JBAT1

3

2

4

1
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Enable/Disable LAN1 Jumper: J5

Figure B-2.  Enable/Disable LAN1 Jumper: J5

Enable/Disable LAN2 Jumper: J8

Figure B-3.  Enable/Disable LAN2 Jumper: J8

BIOS Write Protect Jumper: J2

Figure B-4.  BIOS Write Protect Jumper: J2

Enable LAN1

(Default)

Disable LAN1

2 13 2 13

2

1

3

2

1

3

Enable LAN2

(Default)

Disable LAN2

2 13

Enable Write Protect Disable Write

Protect (Default)

2 13
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Clear CMOS Jumper: JBAT1

The CMOS RAM has a power supply from an external battery to preserve 

the system configuration data. With this power supply, the system can 

automatically boot the OS every time it is turned on. Use the JBAT1 (Clear 

CMOS) jumper to clear the system configuration by shorting pins 2–3.

Figure B-5.  Clear CMOS Jumper: JBAT1

Caution To avoid damaging the mainboard, clear the CMOS only when the system is 

powered off. Also, be sure to return reconnect pins 1–2 after clearing the CMOS.

2 31

Keep Data Clear Data

2 31
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Other Connectors

Figure B-6 shows the locations of other connectors on the NI 8351.

Figure B-6.  NI 8351 Other Connector Locations

1 CPU_FAN1
2 SYSFAN2/1
3 COM2

4 JLCD1
5 JUSB2
6 JACT1/JACT2

7 JFP1
8 SYSFAN4
9 SYSFAN3

10 JCI1
11 JUSB1
12 JGS1

4

5

7

6

11

10

12

1 2

8

9

3
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Chassis Intrusion Switch Connector: JCI1
This connector is connected to a 2-pin chassis switch. If the NI 8351 is 

opened, the switch shorts. The system records this status and shows a 

warning message on the startup screen during boot. To clear the warning, 

you must enter the BIOS utility and clear the record. Refer to BIOS Setup 

in Chapter 2, Installation and BIOS Setup, for information about the Case 

Open Warning feature.

Figure B-7.  Chassis Intrusion Switch Connector (JCI1)

LCD Panel Connector: JLCD1
This connector is for connection to an LCD panel, which shows 

information about current status or mode of the connected system.

Figure B-8.  LCD Panel Connector (JLCD1)

Table B-1.  Chassis Intrusion Switch Connector Signals

Pin Signal Name

1 CINTRU

2 GND

Table B-2.  LCD Panel Connector Signals

Pin Signal Name

1 SOUT

2 SIN

3 NC

4 GND1

2

1

1 2

65
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LAN LED Connectors: JACT1 and JACT2
The LAN LED connectors connect to LAN LEDs, which show LAN 

activity. JACT1 is for the LAN1 jack, and JACT2 is for the LAN2 jack. The 

LAN1 and LAN2 jacks are on the rear panel.

Figure B-9.  LAN LED Connectors (JACT1 and JACT2)

Front Panel Connector: JFP1
The mainboard includes one front panel connector for electrical connection 

to the front panel switches and LEDs. JFP1 is compliant with Intel Front 

Panel I/O Connectivity Design Guide.

Figure B-10.  Front Panel Connector (JFP1)

5 GND0

6 VCC

1 Power Switch
2 Reset Switch

3 HDD LED
4 Power LED

Table B-2.  LCD Panel Connector Signals (Continued)

Pin Signal Name

JACT1

JACT2

+
+

–

–

12

9

4

1

3

2

10
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Front USB Connector: JUSB1 and JUSB2
The mainboard includes two USB 2.0 pin headers, JUSB1 and JUSB2, 

that are compliant with Intel I/O Connectivity Design Guide. USB 2.0 

technology increases data transfer rate up to a maximum throughput of 

480 Mbit/s, which is 40 times faster than USB 1.1, and is ideal for 

connecting high-speed USB interface peripherals such as USB HDD, 

digital cameras, MP3 players, printers, modems, and so on.

Figure B-11.  Front USB Connector (JUSB1 and JUSB2)

Table B-3.  Front Panel Connector Signals

Pin Signal Name Signal Description

1 HD_LED_P Hard disk LED pull-up

2 FP PWR/SLP MSG LED pull-up

3 HD_LED_N Hard disk active LED

4 FP PWR/SLP MSG LED pull-up

5 RST_SW_N Reset switch low reference 

pull-down to GND

6 PWR_SW_P Power switch high reference 

pull-up

7 RST_SW_P Reset switch high reference 

pull-up

8 PWR_SW_N Power switch low reference 

pull-down to GND

9 RSVD_DNU Reserved—do not use

1

9

2

10

1 9

2 10

JUSB1 JUSB2
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Power Saving Switch Connector: JGS1
Attach a power saving switch to this connector. Press the switch once to 

have the system enter the Sleep/Suspend state. Press any key to wake up the 

system.

Figure B-12.  Power Saving Switch Connector (JGS1)

Fan Power Connectors: CPU_FAN1, SYSFAN1/2/3/4

The fan power connectors support system cooling fans with +12 V. When 

connecting wires to the connectors, always remember that the red wire is 

positive and should be connected to the +12 V pin; the black wire is Ground 

and should be connected to GND. If the mainboard has a system hardware 

monitor chipset onboard, you must use a specially designed fan with a 

speed sensor to take advantage of the CPU fan control.

Figure B-13.  Fan Power Connectors (CPU_FAN1 and SYSFAN1/2/3/4)

Table B-4.  Front USB Connector Signals

Pin Signal Name Pin Signal Name

1 VCC 6 USB1+

2 VCC 7 GND

3 USB0– 8 GND

4 USB1– 9 Key

5 USB0+ 10 NC

CPU_FAN1 SYSFAN1/2 SYSFAN3 SYSFAN4

1
2
3
4

1
2
3

3
2
1

123
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Note CPU_FAN1 supports smart fan control. You can set up the smart fan control 

functions in the BIOS setup utility.

Serial Port Header: COM2
The mainboard includes one 9-pin header as a serial port. The port is a 

16550A high-speed communication port that sends and receives 16-byte 

FIFOs. You can attach a serial mouse or other device directly to the header.

Figure B-14.  Serial Port Header (COM2)

Table B-5.  Fan Power Connector Signals

Pin Signal Name

1 GND

2 +12 V

3 SENSOR

4 Control

Table B-6.  Serial Port Header Connector Signals

Pin Signal Name Signal Description

1 DCD Data carry detect

2 SIN Serial in or receive data

3 SOUT Serial out of transmit data

4 DTR Data terminal ready

5 GND Ground

6 DSR Data set ready

7 RTS Request to send

21

9
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PCI Express Slot

The mainboard provides one PCI Express x8 slot. This PCIE_1 slot accepts 

x8 cards and runs at x8 speeds, with an extra PCIE_3 slot for riser cards. 

The slot is PCI Express Specification v1.0a compliant.

Figure B-15.  PCI Express Slot

Upgrading Memory

The mainboard includes four 240-pin ECC DDR-II SDRAM slots with 

maximum memory size of 8 GB. Install at least one memory module in the 

slots. 

Figure B-16 shows the DIMM location on the main board. DIMM1 is on 

the left; DIMM4 is on the right.

8 CTS Clear to send

9 RI Ring indicate

Table B-6.  Serial Port Header Connector Signals (Continued)

Pin Signal Name Signal Description
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Figure B-16.  DIMM Location

Dual-Channel Memory Configuration
For optimum memory performance, you can use dual-channel memory 

configurations. In these configurations, identical memory is installed in 

channels A and B. Figures B-17, B-18, and B-19 show allowed 

configurations for dual-channel memory mode.

Table B-7 shows all possible memory module combinations.

Table B-7.  Memory Module Combinations

DIMM1 

(Channel A)

DIMM2 

(Channel A)

DIMM3 

(Channel B)

DIMM4 

(Channel B) Total Memory

256 MB~1 GB 256 MB~1 GB 512 MB~2 GB

256 MB~1 GB 256 MB~1 GB 512 MB~2 GB

256 MB~1 GB 256 MB~1 GB 512 MB~2 GB

256 MB~1 GB 256 MB~1 GB 512 MB~2 GB

256 MB~1 GB 256 MB~1 GB 256 MB~1 GB 256 MB~1 GB 1 MB~4 GB

1 2 3 4
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Installing memory with different speeds is allowed, but the faster memory 

downshifts to the speed of the slower memory.

Figure B-17 shows two identical DIMMs in DIMM 1 and DIMM 3. You 

can also install identical DIMMs in DIMM 2 and DIMM 4.

Figure B-17.  Two Identical DIMMs in DIMM 1 and DIMM 3

1 Two Identical DIMMs

1 2 3 4

1
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Figure B-18 shows two different pairs of identical DIMMS—two identical 

DIMMs in DIMM 1 an DIMM 3 and two identical DIMMs in DIMM 2 and 

DIMM 4.

Figure B-18.  Two Different Pairs of Identical DIMMs

1 First Pair of Identical DIMMs 2 Second Pair of Identical DIMMs

1 2

1 2 3 4
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Figure B-19 shows four identical DIMMs installed in DIMM 1 through 

DIMM 4.

Figure B-19.  Four Identical DIMMs

Installing DDR Modules
Follow these steps to install DDR modules:

1. Press the cover release buttons on the top of the NI 8351.

2. Push the cover backward to remove it.

3. Align the notch in the center of the DDR DIMM module with the key 

on the DIMM slot. Insert the module vertically into the slot and push 

it in until the pins are fully inserted, as shown below.

1 Four Identical DIMMs

1

1 2 3 4
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4. When the module is fully inserted, the plastic clip at each side of the 

slot automatically closes, as shown below.

5. Replace the NI 8351 cover by sliding the cover forward. Make sure the 

safety lock fits firmly.

Removing DDR Modules
Follow these steps to remove DDR modules:

1. Open the plastic clips on both sides of the module.

2. Remove the module from the slot.

1 Notch 2 Key

1 2
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Upgrading and Replacing Hard Disk Drives

Figure B-20 shows the NI 8351 IDE and SATA connector locations.

Figure B-20.  NI 8351 IDE and SATA Connectors

Hard Disk Connector: IDE1
The mainboard has a 32-bit Enhanced PCI IDE and Ultra DMA 66/100 

controller that provides PIO mode 0~4, Bus Master, and Ultra DMA 66/100 

functions. You can connect up to two hard disk drives, a CD-ROM, and 

other devices.

1 SATA4 2 SATA3 3 IDE1 4 SATA2 5 SATA1

3

4

5

1

2
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Figure B-21 shows the IDE1 connector.

Figure B-21.  IDE1 Connector

SATA Connectors: SATA1–SATA4
The ICH7R south bridge supports four Serial ATA connectors 

(SATA1–SATA4).

SATA connectors are high-speed Serial ATA interface ports. Each supports 

Serial ATA data rates of 300 MB/s. All connectors are fully compliant with 

Serial ATA 2.0 specifications. Each Serial ATA connector can connect to 

one hard disk.

Figure B-22 shows the SATA1–SATA4 connector.

Figure B-22.  SATA1–SATA4 Connector

Hard Disk Removal

Caution Before removing or installing a hard disk drive, be sure the NI 8351 is powered 

off and not connected to AC power.

Follow these steps to install a hard disk drive:

1. Press the cover release buttons on the top of the NI 8351.

2. Push the cover backward to remove it.

1

7
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3. Unscrew the thumb screws securing the hard disk drive cover plate, 

slide the cover plate forward, and remove it.

4. Push the hard disk drive bracket backward to release the hard disk 

drive.

5. Disconnect the hard disk drive power cord and ATA 100 (or SATA) 

cable.

6. Remove the hard disk drive.

Hard Disk Installation

Caution Before removing or installing a hard disk drive, be sure the NI 8351 is powered 

off and not connected to AC power.

Follow these steps to install a hard disk drive:

1. Press the cover release buttons on the top of the NI 8351.

2. Push the cover backward to remove it.

3. Unscrew the hard disk drive cover plate and slide it forward.

4. Turn over the hard disk drive cover plate and remove the hard disk 

drive brackets.

5. Place the first hard disk drive into the chassis. Be sure the hard disk 

drive screw holes align with the chassis disk drive mounting tabs.

6. Connect the hard disk drive power cord and ATA 100 (or SATA) cable.

7. Push the hard disk drive bracket forward to secure the hard disk drive.

8. To install a second hard disk drive, repeat steps 5 through 7.

9. Replace the hard disk drive bracket.

10. Replace the hard disk drive cover plate and tighten the screws to hold 

it in place.

11. Replace the NI 8351 cover by sliding the cover forward. Make sure the 

safety lock fits firmly.

Installing a PCI Express Expansion Card

Follow these steps to install a PCI Express expansion card:

1. Locate the riser card bracket on the NI 8351 chassis.

2. Lift the bracket from the chassis.

3. Unscrew the cover plates on the bracket and set them aside for 

later use.
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4. Insert the PCI Express expansion card into the PCI Express slot on the 

riser card bracket.

5. Screw the expansion card firmly to the riser card bracket.

6. Align the riser card bracket with the PCI Express slot on the chassis. 

Carefully push down the bracket with even force on both sides until it 

is firmly seated in the slot.
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C
Adaptec SATA RAID Utility for 
Intel ICH7R

The southbridge ICH7R provides a hybrid solution that combines two 

independent SATA ports for support of up to two Serial ATA (Serial ATA 

RAID) drives. It uses Adaptec Embedded Serial ATA RAID software to 

support RAID levels 0 and 1 for easy storage subsystem management.

Serial ATA (SATA) is the latest generation of the ATA interface. SATA hard 

drives deliver blistering transfer speeds of up to 150 Mbytes/s with CRC 

error checking. Serial ATA uses long, thin cables, making it easier to 

connect your drive and improving the airflow inside your PC. It also 

features data handling optimizations including tagged command queuing, 

elevator seek, and packet chain command.

Note The information and volumes in your system may differ from those in this appendix.

Introduction

Overview
Adaptec Embedded Serial ATA RAID with HostRAID adds RAID 

functionality to the Serial ATA I/O controller by supporting RAID levels 0 

and 1. HostRAID adds entry-level RAID support to the Serial ATA I/O 

controller. With HostRAID, you can add reliable performance and full data 

protection.

Storage Requirements
Device drivers and storage management software require approximately 

20 MB of disk space.
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Features
Adaptec Embedded Serial ATA RAID Software RAID supports:

• RAID levels 0, 1, and simple volume using Adaptec HostRAID 

technology.

• Operating system-independent configuration and RAID creation using 

Adaptec RAID Configuration (ARC).

• Easy array configuration and status using Adaptec Storage Manager.

• Event logging and broadcasting, including messaging for 

alphanumeric pagers.

Storage Management Software Overview
Adaptec Embedded Serial ATA RAID includes the following software 

tools to manage your storage subsystem:

• Adaptec Storage Manager—Browser Edition—Browser-based 

storage management software that provides all creation, management, 

and data logging functions needed to manage arrays.

• Adaptec RAID Configuration (ARC) Utility—Part of the 

controller’s built-in BIOS code. For details, refer to Adaptec RAID 

Configuration Utility.

• Array Configuration Utility (ACU)—A DOS/BIOS application used 

to create, configure, and manage arrays. For details, refer to Adaptec 

RAID Configuration Utility.

Installing Adaptec Storage Manager—Browser Edition

This section explains how to install Adaptec Storage Manager—Browser 

Edition to enable remote and local management of arrays.

Supported Browsers
To run Adaptec Storage Manager, your computer must have a Web browser 

supporting JavaScript and cookies. The following browsers are supported:

• Internet Explorer (IE) 5.0 or later

• Netscape Navigator 7 or later

When using Adaptec Storage Manager, you must log on to your system 

with administrator privileges.
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Typical, Custom, and Compact Installations
You can select from these setup options:

• Typical (default)—Supports local and remote management; however, 

Adaptec SNMP is not included.

• Custom—For expert users. Primarily used on Web servers or to ensure 

SNMP and Notifier are available for a managed system. You can select 

from these components:

– Managed System Components—If you choose this selection 

only, the installation is the same as a compact installation.

– Adaptec Web Server—Installs components allowing managed 

systems to communicate with Web browsers.

– Adaptec Storage Manager Notifier—Installs messaging, 

including email and broadcaster capabilities.

– Adaptec SNMP—Installs components used by SNMP-based 

applications. Requires Microsoft SNMP agents. Not included in a 

typical installation.

• Compact—Installs only the components required on a remotely 

managed system. Refer to Managed System Components.

Note When you perform a typical or compact installation, components needed for 

communication and remote management are installed automatically.

Installing Adaptec Storage Manager

Note When installing on a FAT 32 file system, the folder being installed is automatically 

hidden.

Complete the following steps to install Adaptec Storage Manager:

1. Verify that a supported browser is installed. Refer to Supported 

Browsers for details.

2. Insert the application CD and wait for the Autorun executable to start 

the installation. If the executable does not run, browse the CD and click 

Autorun.

3. Click Adaptec Utilities.

4. Click Install Adaptec Storage Manager.

5. Click Next in the Install Shield window.
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6. Read the license agreement. If you agree to its terms, click Yes. If not, 

click No and terminate the installation. The Select a Setup Type 

window appears. It includes three types of installations: typical, 

compact, and custom. Refer to Typical, Custom, and Compact 

Installations for details.

7. Choose a setup type and click Next.

8. When you see the Destination Folder, click Next.

9. When you see the setup information, click Next. A progress bar in the 

Setup Status window indicates progress. Before the progress bar shows 

the installation is completed, another window pops up, indicating that 

a security certificate has been generated.

10. Click OK. The Root Certificate Store window appears.

11. Click Yes. The security certificate generated during installation is 

added to the Certificate Store. If you click No at this point, you need to 

install the certificate the first time you run Adaptec Storage Manager.

12. When prompted to restart your computer, accept the default (Yes) and 

click Finish.

13. The system restarts to complete the installation.

14. Remove the application CD before the system restarts; otherwise, the 

installation starts again.

Configuring Internet Browsers
If you are managing a local storage array, and your computer uses a proxy 

server, you must configure your browser to enable Adaptec Storage 

Manager to bypass the proxy server. Also, if you are managing remote 

systems, you must configure Adaptec Storage Manager to bypass the proxy 

server when communicating with these systems.

This section describes the following procedures:

• Configuring Internet Explorer for Local Management

• Configuring Internet Explorer for Remote Management

• Configuring Netscape Navigator for Local Management

• Configuring Netscape Navigator for Remote Management
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Configuring Internet Explorer for Local Management

When using the high security setting, you must enable the following 

settings manually:

• JavaScript

• Cookies (not stored)

In Internet Explorer 5 and 5.5, you do not need to enable the following 

custom level security settings for the local intranet:

• Active scripting

• Allow per session cookies (not stored)

Select Tools»Internet Options to access these settings.

Note Internet Explorer 6.0 has no security setting for cookies. There is no setting for 

blocking intranet cookies.

If you are using a proxy server to access the Internet, you must bypass the 

proxy server to access the Adaptec Storage Manager Web server. Follow 

these steps to verify whether you are using a proxy server:

1. In the Internet Options window, click the Connections tab.

2. Click LAN Settings.

• If the Use a proxy server box is not checked, exit by clicking OK. 

You are not using a proxy server, so ignore this setting.

• If the Use a proxy server box is checked, be sure the Bypass 

proxy server for local addresses box is also checked. Then, click 

the Advanced button. In the Exceptions window, enter 

localhost as an entry.

You are now ready to proceed to Using Adaptec Storage 

Manager—Browser Edition.

Configuring Internet Explorer for Remote Management

Follow these steps if you know the IP address of the system you want to 

manage remotely:

1. Choose Tools»Internet Options»Connections»LAN Settings.

2. Select Use a proxy server for your LAN»Advanced.

3. In the Exceptions section, enter the managed system IP address.
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Configuring Netscape Navigator for Local Management

Follow these steps to configure Netscape Navigator:

1. Log in to your computer with administrator access.

2. Select Edit»Preferences.

3. In the Preferences window, click the right arrow on the Privacy and 

Security line. Ensure that one of the Enable cookies options is 

selected.

4. Select the Advanced line. Ensure that Enable Javascript for 

Navigator is checked.

5. Exit Navigator, then restart it. This enables any settings you have 

modified.

6. You are now ready to proceed to Using Adaptec Storage 

Manager—Browser Edition.

Configuring Netscape Navigator for Remote Management

Follow these steps if you know the IP address of the system you want to 

manage remotely:

1. Choose Edit»Preferences»Advanced»Proxies»Manual proxy 

configuration»No Proxy For.

2. Enter the managed system IP address.

Using Adaptec Storage Manager—Browser Edition

Overview
This section describes how to use Adaptec Storage Manager to manage 

arrays. After you log in, you can use online help to create, configure, and 

manage arrays.

Note Your controller may not support all features described. In most cases, if your 

controller does not support a feature, the feature does not appear in the interface.

With Adaptec Storage Manager, you can:

• Locally manage a system containing a supported Adaptec RAID 

controller with Windows and a supported browser.

• Remotely manage any system containing a supported Adaptec RAID 

controller with Managed System Components (refer to Typical, 
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Custom, and Compact Installations). You can manage a system 

remotely from a system that does not contain a RAID controller.

You can also remotely manage these same systems by either of these 

methods:

• Installing Adaptec Storage Manager on the remote system.

• Directing the remote system browser to the system you want to 

manage.

Architectural Overview
A locally managed system requires these components:

• A supported Web browser.

• The Adaptec Web service, which supplies content displayed on the 

Web browser.

• An Adaptec-supplied storage agent.

A remotely managed system requires these components:

• A supported Web browser on the remote system.

• A storage agent installed on the system with the RAID controller.

• TCP/IP connections on the remote and managed systems.

You can install the Web service on the same remote system as the browser, 

the system with the RAID controller installed, or a third system.

Communication security is ensured because Secure-HTTP (S-HTTP) or 

SSL protocols encrypt all transmitted data. Connection over an Ethernet 

network, a corporate WAN, or VPN is supported.

Logging In
Follow these steps to log in:

1. Click Start»Programs»Adaptec Storage Manager»Adaptec 

Storage Manager—Browser Edition to start Adaptec Storage 

Manager.

2. Enter the host name or IP address of the system you want to manage 

and the username and password you would use to log in to that system.

3. Click Login.
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Note When running Adaptec Storage Manager for the first time:

• You must install a security certificate if you chose not to during the installation 

process. Refer to Installing a Security Certificate for details.

• You are asked to register your software. Refer to Registering Your Software for 

details.

Follow these steps to log in from any system with a Web browser:

1. Launch the Web browser.

2. Enter the IP address for the system you want to access (for example, 

https://10.6.3.14:3513/adaptec) in the address bar and press 

<Enter>. When connection to the remote system is established, the 

System Login screen appears.

Note If you are using a proxy server to access the Internet, you must bypass the proxy 

server to access the Adaptec Storage Manager Web server. Refer to Configuring Internet 

Browsers for details.

3. Enter the host name or IP address of the system you want to manage. 

Also, enter the administrative username and password you would 

normally use to log into that system.

4. Click Login.

Installing a Security Certificate
If you chose not to install a security certificate when you installed Adaptec 

Storage Manager, you must install the certificate when you run the 

application for the first time.

Follow these steps to create the certificate:

1. When the Security Alert window appears, click View Certificate.

2. In the Certificate window, click Install Certificate.

3. In the Certificate Import Wizard window, click Next. The Certificate 

Import Wizard window contents change.

4. Accept the default, Automatically select the certificate store, and 

click Next.

5. On the root Certificate Store window, click Yes. Another Certificate 

Import wizard window appears.

6. Click OK. The Certificate window from Step 2 reappears.
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7. Click OK. You are returned to the Security Alert window from Step 1.

8. Click Yes to finish creating and storing the certificate.

Registering Your Software
After installing and creating a security certificate, you are asked to register 

the product. If your computer has an Internet connection, click Register 

Now. If you must delay registration, click Register Later. If you choose 

Register Later, you are prompted to register the application the next time 

you run it.

The Basics
The action buttons in the Adaptec Storage Manager are:

• Logout—Ends your session and returns you to the login window.

• Rescan—Rescans the system configuration. Typically, a rescan occurs 

automatically when required (for example, after an array is created).

However, the system configuration can change without notifying 

Adaptec Storage Manager. For example, drives inserted or removed 

from a nonintelligent enclosure or an enclosure powered on after you 

logged into Adaptec Storage Manager are not displayed unless you 

manually rescan.

The remaining buttons open additional windows with more detailed 

information. Use these buttons to perform actions or change settings on a 

specific aspect of your storage subsystem:

• Events

• Options

• Help

• Properties

• Tasks

Immediately following the header frame is a controller information line. 

This line includes the model number of the first Adaptec RAID controller 

found in the system and the amount of cache memory (if any) installed on 

a controller.

Beneath the controller information are Physical Devices and Logical 

Devices views, which show connected devices and existing arrays on a 

controller. Controller information and device views are repeated for each 

additional Adaptec RAID controller in the system.
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Select the controller by clicking anywhere on the controller information. 

When the controller is selected, the Events, Properties, and Tasks buttons 

change from blue to amber. This indicates that clicking these buttons 

displays additional windows with information and options specific to a 

controller.

Pop-Up Tool Tips
If you position the cursor over a device or button, a pop-up tool tip appears. 

The tips contain helpful information about button functions and devices.

Physical Devices
The Physical Devices view displays information about the drives and 

enclosures attached to the Adaptec RAID controller. The devices are 

organized by the channel or port they are connected to and shown in 

numerical order.

The display for each channel includes information on maximum speed 

capability, the number of the channel on the controller, and the number of 

devices found (excluding the SCSI controller).

Selecting a channel or device turns the Events, Properties, and Tasks 

buttons amber. This indicates that clicking these buttons displays additional 

windows with information and options specific to that device or channel.

At the top of the Physical Devices view, grouped to the right of View, are 

three view selection buttons. These buttons select the physical devices 

connected to this controller.

Changing How Drives are Displayed

By default, the Physical Devices view displays a condensed view of the 

controller configuration and hides detailed drive information. You can 

access more information either by positioning the cursor over the device or 

clicking the arrowhead to the left of a row of devices.

The selected display mode button appears in a lighter shade of blue than the 

other two buttons. The default display is the Text Description view, but in 

the condensed view shown when Adaptec Storage Manager is loaded, the 

display is the same in all three modes.

If you change the display mode by selecting the other view buttons, a 

yellow arrow flashes to the left of any devices where the condensed display 

omits information.
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An icon is always the first entry on each device line. The hard disk drive 

icon represents a hard disk drive. If a + symbol appears with the hard disk 

drive icon, the drive is a hot spare. Different icons represent other devices.

View

When the default display mode is expanded, it shows the following 

information about each device:

• Drive capacity

• Drive manufacturer and model number

• SCSI drive ID or Serial ATA port number

When expanded, the Full Size Capacity View button and Relative Size 

Capacity View button represent each drive as a bar. A drive that is not part 

of any array is shaded blue surrounded by a dotted line.

The Full Size Capacity View button displays a full-length bar for each 

drive, regardless of capacity.

The Relative Size Capacity View button displays a proportional bar for 

each drive. The largest capacity drive is shown full length. The other drives 

are shown proportional to the drive capacity, relative to the largest drive.

Any part of a drive in an array is shown as a gray segment within the bar. 

Selecting any gray segment highlights it in amber and, in the Logical 

Devices view, highlights the array of which this segment is a member.

In either the Full Size Capacity view or Relative Size Capacity view, a small 

portion at each end of the drive may be shown in dark gray.

The segment at the end of the drive may vary in size from drive to drive 

because, in addition to the RAID signature, the controller may also limit the 

usable capacity of each drive. This is because drives of the same apparent 

capacity from different manufacturers, or even different models from the 

same manufacturer, actually vary slightly in true capacity. Although this is 

not an issue in normal operation, it can be when assigning hot spares or 

replacing a failed drive. If the controller uses the maximum capacity of a 

drive and a hot spare or replacement drive is a few megabytes smaller, it 

cannot replace the failed drive. By rounding drive capacities down to the 

nearest 2 MB, this possibility is effectively eliminated.
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Logical Devices
As described earlier, when Adaptec Storage Manager loads, the Logical 

Devices view is expanded, and you can see the arrays on a controller.

At the top of this view are the Create, Modify, and Delete buttons. Each 

button opens a wizard for the corresponding function.

Use the Modify button to:

• Change an array from one RAID level to another

• Expand an array

• Change a RAID 0 stripe size

For detailed instructions for these buttons, refer to the online help.

The Logical Devices view main area displays the arrays on a controller. The 

area defaults to a condensed view of top-level arrays.

Note Use the Options button to display second-level arrays if your controller supports 

them.

This condensed view shows the RAID level of each device and whether it 

is protected by a hot spare.

If a global hot spare exists, arrays show as protected if the hot spare is large 

enough to protect them.

In the expanded view, the array icons are arranged vertically. Alongside 

them are the array capacity, name, and type.

Selecting an array by clicking on it highlights the following in amber:

• All drives or segments that form the array in the Physical Devices view.

• The Events, Properties, and Tasks buttons in the header frame. 

Selecting any button displays a new window with additional 

information and options specific to that array.

Note In Windows Server 2003, to see animated icons for Adaptec Storage Manager 

logical devices, go to Internet Explorer Properties»Advanced»Multimedia and select 

Play animations in Web Pages.
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Adaptec RAID Configuration Utility

The Adaptec RAID Configuration (ARC) utility is an embedded BIOS 

utility that includes:

• The Array Configuration Utility (ACU)—Use this utility to create, 

configure, and manage arrays.

• Disk Utilities—Use these utilities to format and verify disks.

To run ARC, press <Ctrl-A> when the following message appears during 

system startup:

Press <Ctrl-A> for Adaptec RAID Configuration Utility

The ARC menu appears, presenting the Array Configuration Utility (ACU) 

and disk utilities options.

To select an option from this or any ARC menu, browse with the arrow keys 

and press <Enter>. In some cases, selecting an option displays another 

menu. To return to the previous menu at any time, press <Esc>.

Using the Array Configuration Utility
Use the Array Configuration Utility (ACU) to create, manage, and delete 

arrays from the controller BIOS and initialize drives.

Managing Arrays
Use the Manage Arrays option to view array properties and members and 

delete arrays. The following sections describe these operations.

Viewing Array Properties

Follow these steps to view the properties of an existing array:

1. At the BIOS prompt, press <Ctrl-A>.

2. From the ARC menu, select Array Configuration Utility (ACU).

3. From the ACU menu, select Manage Arrays.

4. In the List of Arrays dialog box, select the array to view and press 

<Enter>. The Array Properties dialog box appears, showing detailed 

information about the array. The physical disks associated with the 

array are displayed here.

5. Press <Esc> to return to the previous menu.
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Deleting Arrays

Caution Back up the data in an array before deleting it. Otherwise, all array data is lost. 

You cannot restore arrays.

Follow these steps to delete an existing array:

1. Power on your computer and press <Ctrl-A> when prompted to access 

the ARC utility.

2. From the ARC menu, select Array Configuration Utility (ACU).

3. From the ACU menu, select Manage Arrays.

4. Select the array to delete and press Delete.

5. In the Array Properties dialog box, select Delete and press <Enter>. 

The following prompt displays:

Warning!! Deleting the array will render array 

unusable. Do you want to delete the array? (Yes/No):

In RAID 1, the following prompt also displays:

Deleting the partition will result in data loss! Do 

you also want to delete the partition? (Yes/No):

6. Click Yes to delete the array or partition or No to return to the previous 

menu.

7. Press <Esc> to return to the previous menu.

Creating Arrays
Before creating arrays, be sure the disks for the array are connected and 

installed in your system. Note that disks with no usable space and 

unitialized disks are shown in gray, and you cannot use them. Refer to 

Initializing Disk Drives.

Follow these steps to create an array:

1. Power on your computer and press <Ctrl-A> when prompted to access 

the ARC utility.

2. From the ARC menu, select Array Configuration Utility (ACU).

3. From the ACU menu, select Create Array.

4. Select the disks for the new array and press <Insert>. To deselect any 

disk, highlight the disk and press <Delete>.

5. Press <Enter> when both disks for the new array are selected. The 

Array Properties menu displays.
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Assigning Array Properties

Note After you create the array and assign its properties, you cannot change the array 

properties using the ACU. Instead, use Adaptec Storage Manager.

Follow these steps to assign properties to the new array:

1. In the Array Properties menu, select an array type and press <Enter>. 

Notice that only the available array types, RAID 0 and RAID 1, are 

displayed. Each type requires two drives.

2. Enter an optional label for the array and press <Enter>.

3. Select the desired stripe size for RAID 0. Available stripe sizes are 16, 

32, and 64 KB (default).

Note Adaptec recommends that you do not change the default.

4. Use Create RAID via to select creation methods for RAID 0 and 

RAID 1. The following table includes examples of when each is 

appropriate.

RAID Level Create Via Appropriate Use

RAID 0 No Init Creating a RAID 0 on new 

drives.

RAID 0 Migrate1 Creating a RAID 0 from 

one new drive and one 

drive with data you want 

to preserve.

RAID 1 Build1 Anytime you want to 

create a RAID 1, 

especially with data on 

one drive that you want to 

preserve.

RAID 1 Clear Creating a RAID 1 on new 

drives, or when you want 

to ensure that the array 

contains no data after 

creation.
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Notes:

• Before adding a new drive to an array, back up any data contained 

on the new drive. Otherwise, you will lose all data.

• If you stop the Build or Clear process on a RAID 1 from the ACU, 

you can restart it only from Adaptec Storage Manager. (Refer to 

Chapter 2, Installation and BIOS Setup, for details.)

• A RAID 1 created using the Quick Init option may return some 

data miscompares if you later run a consistency check. This is 

normal and is not a cause for concern.

• The ACU allows you to use drives of different sizes in a RAID 1. 

However, during a build operation you can select only the smaller 

drive as the source or first drive.

• When migrating from single volume to RAID 0, you can migrate 

from a larger drive to a smaller drive. However the destination 

drive must be at least half the capacity of the source drive.

• You should not migrate or build an array on Windows dynamic 

disks (volumes), as this results in data loss.

5. When you are finished, click Done.

Caution Do not interrupt the creation of a RAID 0 using the migrate option. If you do, you 

cannot restart or recover the source drive data.

Initializing Disk Drives
If an installed disk does not appear in the disk selection list for creating a 

new array or appears grayed out, you may need to initialize it before you 

can use it as part of an array. You must initialize drives attached to the 

controller before using them in an array.

Caution Initializing a disk overwrites the disk partition table and makes disk data 

inaccessible. If the drive is used in an array, you may not be able to use the array again. Do 

not initialize a disk that is part of a boot array. To determine which disks are associated with 

a particular array, refer to Viewing Array Properties.

RAID 1 Quick Init Fastest way to create a 

RAID 1. Appropriate 

when using new drives.

1 If you select Migrate for RAID 0 or Build for RAID 1, you are asked to select the source 

drive. The source drive contents are preserved. However, the data on the new drive is lost.

RAID Level Create Via Appropriate Use
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To initialize drives:

1. Power on your computer and press <Ctrl-A> when prompted to access 

the ARC utility.

2. From the ARC menu, select Array Configuration Utility (ACU).

3. Select Initialize Drives.

4. Use the up and down arrow keys to highlight the disk to initialize and 

press <Insert>.

5. Repeat step 4 so that both drives to be initialized are selected.

6. Press <Enter>.

7. Read the warning message and be sure you have selected the correct 

disk drives to initialize. Press <Y> to continue.

Using the Disk Utilities
Use the Disk Utilities to format or verify your Serial ATA hard disk media.

Follow these steps to access the disk utilities:

1. Power on your computer and press <Ctrl-A> when prompted to access 

the ARC utility.

2. From the ARC menu, select Disk Utilities.

3. Select the desired disk and press <Enter>. You are offered the 

following options:

Caution Formatting destroys all data on the drive. Be sure to back up your data before 

performing this operation.

• Format Disk—Simulates a low-level format of the hard drive by 

writing zeros to the entire disk. Serial ATA drives are low-level 

formatted at the factory and do not need to be low-level formatted 

again.

• Verify Disk Media—Scans the disk drive media for defects.
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D
Technical Support and 
Professional Services

Visit the following sections of the National Instruments Web site at 

ni.com for technical support and professional services:

• Support—Online technical support resources at ni.com/support 

include the following:

– Self-Help Resources—For answers and solutions, visit the 

award-winning National Instruments Web site for software drivers 

and updates, a searchable KnowledgeBase, product manuals, 

step-by-step troubleshooting wizards, thousands of example 

programs, tutorials, application notes, instrument drivers, and 

so on.

– Free Technical Support—All registered users receive free Basic 

Service, which includes access to hundreds of Application 

Engineers worldwide in the NI Developer Exchange at 

ni.com/exchange. National Instruments Application Engineers 

make sure every question receives an answer.

For information about other technical support options in your 

area, visit ni.com/services or contact your local office at 

ni.com/contact. 

• Training and Certification—Visit ni.com/training for 

self-paced training, eLearning virtual classrooms, interactive CDs, 

and Certification program information. You also can register for 

instructor-led, hands-on courses at locations around the world.

• System Integration—If you have time constraints, limited in-house 

technical resources, or other project challenges, National Instruments 

Alliance Partner members can help. To learn more, call your local 

NI office or visit ni.com/alliance.

If you searched ni.com and could not find the answers you need, contact 

your local office or NI corporate headquarters. Phone numbers for our 

worldwide offices are listed at the front of this manual. You also can visit 

the Worldwide Offices section of ni.com/niglobal to access the branch 

office Web sites, which provide up-to-date contact information, support 

phone numbers, email addresses, and current events.
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Glossary

Symbol Prefix Value

p pico 10–12

n nano 10–9

µ micro 10– 6

m milli 10–3

k kilo 103

M mega 106

G giga 109

T tera 1012

Symbols

° Degrees

Ω Ohms

% Percent

A

A Amperes

A/D Analog-to-digital. Most often used as A/D converter.

AC Alternating Current

ACPI Advanced Configuration and Power Management Interface

ANSI American National Standards Institute

API Application Programming Interface. A standardized set of subroutines or 

functions along with the parameters that a program can call.
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APIC Advanced Programmable Interrupt Controller

ASCII American Standard Code for Information Exchange

ASIC Application-Specific Integrated Circuit

ATA The specification formulated in the 1980s that defines the IDE drive 

interface.

B

B Bytes

BIOS Basic Input/Output System; BIOS functions are the fundamental level 

of any PC or compatible computer. BIOS functions embody the basic 

operations needed for successful use of the computer’s hardware resources.

C

C Celsius

CAS Column Address Strobe

CMOS Complementary Metal Oxide Semiconductor; a process used in making 

chips

COM Communications port

CPU Central Processing Unit

CSA Carrier Serving Area

D

D/A Digital-to-analog—most often used as an abbreviation for a D/A converter 

(also known as DAC).

DC Direct Current

DDR Double Data Rate

DIMM Dual In-line Memory Module
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DMA Direct Memory Access; a method by which data is transferred between 

devices and internal memory without intervention of the central processing 

unit

DMI Desktop Management Interface

DRAM Dynamic RAM (Random Access Memory); storage that the computer must 

refresh at frequent intervals

E

ECC Error-Correcting Code

EEPROM Electronically Erasable Programmable Read Only Memory

EMC Electromagnetic Compatibility

EMI Electromagnetic Interference

EPP Enhanced Parallel Port

F

FCC Federal Communications Commission

G

GB Gigabytes of memory

GPIB General Purpose Interface Bus (IEEE 488)

H

HDD Hard Disk Drive

Hz Hertz; cycles per second
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I

I/O Input/output; the techniques, media, and devices used to achieve 

communication between machines and users

IDE Integrated Drive Electronics; hard disk and built-in controller

IEEE Institute of Electrical and Electronics Engineers

IRQ* Interrupt signal

ISA Industry Standard Architecture; the original PC bus architecture, 

specifically the 16-bit AT bus

K

KB Kilobytes of memory

L

LAN Local Area Network; communications network that serves users within 

a confined geographical area. It is made up of servers, workstations, a 

network operating system, and a communications link.

LCD Liquid Crystal Display—a display technology using polarizing filters and 

liquid crystal cells.

LED Light-emitting diode

M

MAX Measurement & Automation Explorer

MB Megabytes of memory

MPS Multiprocessor Specification

MTBF Mean Time Between Failure

MTTR Mean Time to Repair

MXI Multisystem eXtension Interface 
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N

NI-DAQ The National Instruments software for data acquisition instruments

NI-VISA The National Instruments implementation of the VISA standard; an 

interface-independent software that provides a unified programming 

interface for VXI, GPIB, and serial instruments

P

PCI Peripheral Component Interconnect. The PCI bus is a high-performance 

32-bit or 64-bit bus with multiplexed address and data lines.

PEF Platform Event Filter

PIO Programmed Input/Output

POSC Power On Self Configuration

POST Power On Self Test

PXI PCI eXtensions for Instrumentation; an open implementation of 

CompactPCI that adds electrical features that meet the high-performance 

requirements of instrumentation applications by providing triggering, local 

buses, and system clock capabilities. PXI also offers two-way 

interoperability with CompactPCI products.

R

RAM Random Access Memory; the computer’s primary workspace

RAS Row Address Strobe

RMS Root Mean Squared

RTC Real Time Clock; an electronic circuit that maintains the time of day and 

also can provide timing signals for timesharing operations
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S

SATA Serial-ATA. See also ATA.

SCSI Small Computer System Inteface

SDRAM A form of dynamic RAM memory that is about 20% faster than EDO 

RAM. SDRAM interleaves two or more internal memory arrays so that 

while one array is being accessed, the next one is being prepared for access. 

SDRAM-II is a faster version of SDRAM technology.

SO-DIMM Small Outline Dual In-line Memory Module

SPD Serial Presence Detect EEPROM

SRAM Static RAM; a memory chip that requires power to hold its content. It does 

not require refresh circuitry as a dynamic RAM chip, but it does take up 

more space and uses more power.

U

UDMA Ultra Direct Memory Access. See also DMA.

USB Universal Serial Bus

V

V Volts

VGA Video Graphics Array; the minimum video display standard for all PCs

VME Versa Module Eurocard

VXI VME eXtensions for Instrumentation

W

W Watts

WDT Watchdog Timer
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Numerics
82541 GI LAN active LED connector (JACT2)

pinout (figure), B-8

82547 GI LAN active LED connector (JACT1)

pinout (figure), B-8

A
AC power cables (table), 1-2

Adaptec RAID Configuration Utility, C-13

assigning array properties, C-15

creating arrays, C-14

deleting arrays, C-14

disk utilities, using, C-17

initializing disk drives, C-16

managing arrays, C-13

using, C-13

viewing array properties, C-13

Adaptec SATA RAID utility for Intel 

ICH7R, C-1

features, C-2

introduction, C-1

overview, C-1

storage management software 

overview, C-2

storage requirements, C-1

Adaptec Storage Manager

architectural overview, C-7

basics, C-9

changing how drives are displayed, C-10

configuring Internet browsers, C-4

Internet Explorer

for local management, C-5

for remote management, C-5

Netscape Navigator

for local management, C-6

for remote management, C-6

installing, C-2, C-3

installing a security certificate, C-8

logging in, C-7

Logical Devices view, C-12

Physical Devices view, C-10

pop-up tool tips, C-10

registering your software, C-9

supported browsers, C-2

typical, custom, and compact 

installations, C-3

using, C-6

overview, C-6

view, C-11

advanced chipset control, 2-7

Advanced menu, 2-4, 2-7

advanced processor options, 2-8

after power failure, 2-14

ASF configuration, 2-9

auto fan speed control, 2-9

available to OS, 2-6

B
base I/O address

floppy disk controller, 2-12

parallel port, 2-11

baud rate, 2-10

BIOS

checking settings, 4-1

flashing new BIOS, 4-4

setup, 2-3

advanced chipset control, 2-7

Advanced menu, 2-4, 2-7

advanced processor options, 2-8

after power failure, 2-14

ASF configuration, 2-9

auto fan speed control, 2-9
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available to OS, 2-6

base I/O address

floppy disk controller, 2-12

parallel port, 2-11

baud rate, 2-10

BIOS boot timeout, 2-9

boot features menu, 2-6

Boot menu, 2-5, 2-14

boot priority order, 2-14

boot-time diagnostic screen, 2-6

clear all DMI event logs, 2-12

COM port address, 2-10

console connection, 2-10

console redirection, 2-9

console type, 2-10

continue C. R. after POST, 2-10

CPU/SYS Temperature, 2-9

discard changes, 2-15

DMI event logging, 2-12

ECC condition, 2-7

ECC error handler, 2-7

ECC event logging, 2-12

entering, 2-3

event logging, 2-12

excluded from boot order, 2-14

exit discarding changes, 2-14

Exit menu, 2-5, 2-14

exit saving changes, 2-14

floppy check, 2-6

floppy disk controller, 2-11

flow control, 2-10

getting help, 2-4

general help, 2-4

Main menu, 2-4

submenus, 2-4

hardware monitor, 2-9

hyperthreading, 2-8

I/O device configuration, 2-10

IDE primary master/slave, 2-5

installed memory, 2-6

integrated device control, 2-10

interleave mode, 2-7

interrupt, 2-11

legacy USB support, 2-10

load setup defaults, 2-15

Main menu, 2-4, 2-5

mark DMI events as read, 2-12

menu bar, 2-4

minimum watchdog timeout, 2-9

mode, 2-11

OS boot timeout, 2-9

parallel ATA, 2-7

parallel port, 2-11

password on boot, 2-13

Power menu, 2-5, 2-13

power-on wait time, 2-9

processor power management, 2-8

quickboot mode, 2-6

resume date, 2-13

resume on LAN, 2-13

resume on modem ring, 2-13

resume on time, 2-13

resume time, 2-13

SATA AHCI enable, 2-8

SATA controller mode option, 2-7

SATA port 1/2/3/4, 2-5

SATA RAID enable, 2-8

save changes, 2-15

Security menu, 2-4, 2-12

serial ATA, 2-7

serial port A/B, 2-11

set max ext CPUID = 3, 2-8

set supervisor password, 2-12

set user password, 2-13

single logical proc. mode, 2-8

summary screen, 2-6

supervisor password is, 2-12

SYS Fan1/SYS Fan2 Speed, 2-9

system backup reminder, 2-13

system date, 2-5
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system time, 2-5

used by devices, 2-6

user password is, 2-12

V(12V), 2-9

V(3Vsb), 2-9

V(V_1P5), 2-9

V(VCC3), 2-9

V(VCC5), 2-9

V(Vcore), 2-9

view DMI event log, 2-12

virus check reminder, 2-13

BIOS boot timeout, 2-9

BIOS write protect (J2) jumper settings, B-4

boot features menu, 2-6

Boot menu, 2-5, 2-14

boot options, configuring controller, 4-2

boot priority order, 2-14

boot-time diagnostic screen, 2-6

C
cables, power (table), 1-2

CE compliance specifications, A-4

chassis intrusion switch connector (JCI1), B-7

pinout (figure), B-7

signals (table), B-7

clear all DMI event logs, 2-12

clear CMOS jumper (JBAT1) settings, B-5

COM port address, 2-10

common configuration questions, 4-1

boot options, 4-1

chassis configuration, 4-2

general questions, 4-1

upgrade information, 4-4

connector locations (figure), B-6

connectors

chassis intrusion switch connector 

(JCI1), B-7

Ethernet connector and signals, 3-7

fan power connectors (CPU_FAN1 and 

SYSFAN1/2/3/4), B-10

front panel connector (JFP1), B-8

front USB connectors (JUSB1 and 

JUSB2), B-9

LAN LED connectors (JACT1 and 

JACT2), B-8

LCD panel connector (JLCD1), B-7

parallel port connector and signals, 3-4

PCI Express slot, B-12

peripheral expansion overview 

(table), 3-1

power saving switch connector 

(JGS1), B-10

PS/2 connector and signals, 3-2

serial connector and signals, 3-5

serial port header (COM2), B-11

Universal Serial Bus (USB) connector 

and signals, 3-3

VGA connector and signals, 3-6

console connection, 2-10

console redirection, 2-9

console type, 2-10

continue C. R. after POST, 2-10

conventions used in the manual, xi

cooling

air cooling of NI 8351, 2-2

CPU specifications, A-2

CPU/SYS Temperature, 2-9

D
DDR DIMMs

from National Instruments (note), 1-6

installing, B-16

removing, B-17

debug functions before boot to OS 

(table), 2-18

diagnostic tools (NI resources), D-1

DIMM location (figure), B-13

directories and files installed on hard 

drive, 2-15

discard changes, 2-15
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DMI event logging, 2-12

documentation

conventions used in manual, xi

NI resources, D-1

related documentation, xii

drivers, 2-15

obtaining latest drivers, 4-4

NI resources, D-1

dual-channel memory configuration, B-13

E
ECC condition, 2-7

ECC error handler, 2-7

ECC event logging, 2-12

electrical specifications, A-1

electromagnetic compatibility 

specifications, A-4

environmental specifications, A-3

Ethernet

overview (table), 3-1

Ethernet connector and signals, 3-7

location and pinout (figure), 3-8

signals (table), 3-8

event logging, 2-12

examples (NI resources), D-1

excluded from boot order, 2-14

exit discarding changes, 2-14

Exit menu, 2-5, 2-14

exit saving changes, 2-14

F
fan power connectors (CPU_FAN1 and 

SYSFAN1/2/3/4), B-10

pinout (figure), B-10

signals (table), B-11

files and directories installed on hard 

drive, 2-15

floppy check, 2-6

floppy disk controller, 2-11

floppy drive, using external floppy drive, 4-4

flow control, 2-10

four identical DIMMs (figure), B-16

front panel connector (JFP1), B-8

pinout (figure), B-8

signals (table), B-9

front USB connector (JUSB1 and JUSB2)

pinout (figure), B-9

front USB connector (JUSB2)

signals (table), B-10

front USB connectors (JUSB1 and 

JUSB2), B-9

G
ground, connecting, 2-3

H
hard disk drives

connector, IDE1, B-18

files and directories installed on, 2-15

recovery, 2-25

specifications, A-2

upgrading and replacing, B-18

hard disk connector, IDE 1, B-18

installation, B-20

removal, B-19

SATA connectors supported, SATA1 

to SATA4, B-19

hardware monitor, 2-9

help, technical support, D-1

HW Monitor functions (table), 2-19

hyperthreading, 2-8

I
I/O device configuration, 2-10

IDE connector location (figure), B-18

IDE controller, using SCSI hard drive in 

addition, 4-1
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IDE primary master/slave, 2-5

IDE1 connector (figure), B-19

images directory, 2-15

installation, 2-2

configuration in MAX (figure), 4-3

installation, configuration, and operation

connecting safety ground, 2-3

site considerations, 2-2

testing power up, 2-3

unpacking the NI 8351, 1-1

installed memory, 2-6

installing a PCI Express expansion card, B-20

installing an operating system, 2-25

installing hard disk drives, B-20

installing NI 8351, 2-1

instrument drivers (NI resources), D-1

integrated device control, 2-10

interleave mode, 2-7

interrupt, 2-11

J
jumper locations (figure), B-3

jumper settings, B-3

BIOS write protect (J2), B-4

clear CMOS jumper (JBAT1), B-5

enable/disable LAN1 (J5), B-4

enable/disable LAN2 (J8), B-4

K
key features, 1-2

keyboard

overview (table), 3-1

kit contents, 1-1

KnowledgeBase, D-1

L
LabVIEW, 1-7

LabWindows/CVI, 1-7

LAN1 jumper (J5) settings, B-4

LAN2 jumper (J8) settings, B-4

LCD function menu, 2-16

debug functions before boot to OS 

(table), 2-18

HW Monitor functions (table), 2-19

LCD Info and H/W Monitor Control 

Panel menu structure (figure), 2-16

LCD info functions (table), 2-19

System Conf Control Panel menu 

structure (figure), 2-17

System Conf functions (table), 2-20

LCD Info and H/W Monitor Control Panel 

menu structure (figure), 2-16

LCD info functions (table), 2-19

LCD panel connector (JLCD1), B-7

pinout (figure), B-7

signals (table), B-7

LEDs, front panel, 4-1

legacy USB support, 2-10

Linux support, 1-8

load setup defaults, 2-15

M
Main menu, 2-4, 2-5

mainboard specifications, A-1

maintenance of PXI-1031

cleaning

exterior cleaning, 2-26

manuals directory, 2-15

mark DMI events as read, 2-12

mating connector

Ethernet, 3-7

serial, 3-5

USB, 3-3

VGA, 3-6

Measurement Studio, 1-7

mechanical specifications, A-3
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memory

specifications, A-3

upgrading, 1-6, B-12

four identical DIMMs (figure), B-16

installing DDR modules, B-16

removing DDR modules, B-17

two different pairs of identical 

DIMMs (figure), B-15

two identical DIMMs in DIMM 1 and 

DIMM 3 (figure), B-14

menu bar, 2-4

minimum watchdog timeout, 2-9

mode, 2-11

modular instruments, 1-8

N
National Instruments

software, 1-7

support and services, D-1

NI 8351

BIOS setup, 2-3

boot options, 4-1

chassis configuration, 4-2

chassis cooling considerations, 2-2

common configuration questions, 4-1

configuration, hardware, B-1

connector locations (figure), B-6

connectors, 3-1

chassis intrusion switch connector 

(JCI1), B-7

Ethernet, 3-7

fan power connectors (CPU_FAN1 

and SYSFAN1/2/3/4), B-10

front panel connector (JFP1), B-8

front USB connectors (JUSB1 and 

JUSB2), B-9

LAN LED connectors (JACT1 and 

JACT2), B-8

LCD panel connector (JLCD1), B-7

parallel port connector and 

signals, 3-4

PCI Express slot, B-12

power saving switch connector 

(JGS1), B-10

PS/2 connector and signals, 3-2

serial connector and signals, 3-5

serial port header (COM2), B-11

Universal Serial Bus (USB) 

connector and signals, 3-3

VGA, 3-6

description, 1-5

DIMM location (figure), B-13

drivers and software installed, 2-15

dual-channel memory 

configuration, B-13

front panel

LEDs, 4-1

hard disk drive recovery, 2-25

hardware configuration, B-1

IDE connector location (figure), B-18

installation, 2-1, 2-2

installing a PCI Express expansion 

card, B-20

installing an operating system, 2-25

jumper locations (figure), B-3

jumper settings, B-3

key features, 1-2

LCD function menu, 2-16

memory upgrades, 1-6

optional equipment, 1-6

overview, 1-6

peripheral expansion overview 

(table), 3-1

power source, connecting to, 2-3

rack mounting, 1-6, 2-22

safety and caution notices, 2-1

safety ground, connecting, 2-3

SATA connector locations (figure), B-18

software, 1-7
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troubleshooting, 5-1

upgrade information, 4-4

upgrading and replacing hard disk 

drives, B-18

upgrading memory, B-12

upgrading RAM, 4-4

USB floppy disk drive, 1-6

using with PXI chassis, 4-2

NI support and services, D-1

NI-DAQmx, 1-7

NI-VISA, 1-8

O
operating system

installing, 2-25

optional equipment, 1-6

memory upgrades, 1-6

rack mount kits, 1-6

USB floppy disk drive, 1-6

OS boot timeout, 2-9

os directory, 2-15

overview, 1-6

P
parallel ATA, 2-7

parallel port, 2-11

connector and signals, 3-4

connector location and pinout 

(figure), 3-4

connector signals (table), 3-4

overview (table), 3-1

password on boot, 2-13

PCI Express expansion card, installing, B-20

PCI Express Slot

pinout (figure), B-12

PCI Express slot, B-12

peripheral expansion overview (table), 3-1

power cables (table), 1-2

Power menu, 2-5, 2-13

power saving switch connector (JGS1), B-10

pinout (figure), B-10

power supply

connecting to, 2-3

power up, testing, 2-3

power-on wait time, 2-9

processor power management, 2-8

programming examples (NI resources), D-1

PS/2

connector and signals, 3-2

connector location and pinout 

(figure), 3-2

connector signals (table), 3-2

pxisys.ini file, 4-2

Q
quickboot mode, 2-6

R
rack mounting, 1-6, 2-22

RAM

DDR DIMMs from National Instruments 

(note), 1-6

upgrading, 4-4

rear panel

connectors, 3-1

related documentation, xii

removing hard disk drives, B-19

replacing hard disk drives, B-18

resume date, 2-13

resume on LAN, 2-13

resume on modem ring, 2-13

resume on time, 2-13

resume time, 2-13

S
safety and caution notices, 2-1

safety ground, connecting, 2-3
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safety specifications, A-4

SATA AHCI enable, 2-8

SATA connector locations (figure), B-18

SATA connectors, SATA to SATA4, B-19

SATA controller mode option, 2-7

SATA port 1/2/3/4, 2-5

SATA RAID enable, 2-8

SATA RAID utility, C-1

SATA1 and SATA2 connector (figure), B-19

save changes, 2-15

Security menu, 2-4, 2-12

serial ATA, 2-7

serial connector, 3-5

connector locations and pinout 

(figure), 3-5

connector signals (table), 3-6

serial port A/B, 2-11

serial port header (COM2), B-11

pinout (figure), B-11

signals (table), B-11

serial ports, 3-1

See also COM1 and COM2 connectors

set max ext CPUID = 3, 2-8

set supervisor password, 2-12

set user password, 2-13

single logical proc. mode, 2-8

software

See also drivers

installed on your hard drive, 2-15

LabVIEW, 1-7

LabWindows/CVI, 1-7

Measurement Studio, 1-7

National Instruments software, 1-7

NI resources, D-1

NI-DAQmx, 1-7

NI-VISA, 1-8

specifications

CE compliance, A-4

CPU, A-2

electrical, A-1

electromagnetic compatibility, A-4

environmental, A-3

hard disk drive, A-2

mainboard, A-1

mechanical, A-3

memory, A-3

safety, A-4

summary screen, 2-6

supervisor password is, 2-12

support

technical, D-1

SYS Fan1/SYS Fan2 Speed, 2-9

system backup reminder, 2-13

System Conf Control Panel menu structure 

(figure), 2-17

System Conf functions (table), 2-20

system date, 2-5

system time, 2-5

T
technical support, D-1

testing power up, 2-3

training and certification (NI resources), D-1

troubleshooting

controller does not boot, 5-1

damaged module, 5-2

NI resources, D-1

video display, 5-1

two different pairs of identical DIMMs 

(figure), B-15

two identical DIMMs in DIMM 1 and 

DIMM 3 (figure), B-14

U
Universal Serial Bus (USB), 3-1

connector location and pinout 

(figure), 3-3

connector signals (table), 3-3

connectors and signals, 3-3

overview (table), 3-1
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unpacking the NI 8351, 1-1

upgrading hard disk drives, B-18

upgrading memory, B-12

installing DDR modules, B-16

removing DDR modules, B-17

USB floppy disk drive, 1-6

used by devices, 2-6

user password is, 2-12

V
V(12V), 2-9

V(3Vsb), 2-9

V(V_1P5), 2-9

V(VCC3), 2-9

V(VCC5), 2-9

V(Vcore), 2-9

VGA

connector and signals, 3-6

connector signals (table), 3-7

location and pinout (figure), 3-6

overview (table), 3-1

video, 3-1

See also VGA

view DMI event log, 2-12

virus check reminder, 2-13

W
Web resources, D-1
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